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Introduction

1. Introduction to BIAsimulation

1.1 Scope of BIAsimulation

BIAsimulation software is a Windows-based software package which
generates simulated sensorgrams for a range of real-time BIA
applications. The package includes modules for simulating the
following applications:

* basic kinetic analysis, including cooperativity, steric hindrance and
mass transport limitations as well as experimental parameters such
as signal noise and baseline drift. Facilities for simulating the effect
of mass transport limitations are also provided.

* kinetics obtained with heterogeneous ligands.
* kinetics obtained with heterogeneous analytes.

* epitope mapping, allowing user-defined affinity constants for the
various epitope probes.

 multi-site binding experiments.
* concentration analysis.
BIAsimulation software serves three main purposes:

e It is a valuable learning aid in getting acquainted with the concepts
and range of applications of BIA. By running BIAsimulation, new
users can familiarize themselves with the sort of results that may be
expected from BIA experiments.

* It provides help in designing suitable experimental conditions for
practical investigations. In some cases, the feasibility of an
experimental project can be tested with BIAsimulation (e.g. the
ability to distinguish between kinetic models for an interaction or to
perform epitope mapping with antibodies of a given affinity range).

¢ It can provide help in testing the validity of kinetic evaluation of BIA
measurements. In kinetic analysis with BIAevaluation, kinetic
constants are normally derived from application of an analysis
model to selected parts of the experimental sensorgrams.
BIAsimulation can be used to generate whole sensorgrams using the
experimentally obtained constants, and comparison of the actual and
simulated data can reveal whether the model is valid over the whole
time span of the sensorgrams. In addition, BIAsimulation can be
used to explore the effects of varying experimental parameters, and
can thus help to decide which experiments might be crucial in
distinguishing between alternative kinetic models.

BIAsimulation Software Handbook 1-1
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Note: BIAsimulation does not take account of steric hindrance
effects at high surface binding levels, nor of the dynamic range
of current BIA instrumentation (maximum response
approximately 35,000 RU). Simulations performed with high
concentrations of large molecules may for this reason not
correspond to the results that would be obtained in practice
under the same conditions. This consideration is particularly
relevant to simulation multi-site binding and concentration
analysis using sandwich techniques.

1.2 General interaction techniques

BIAsimulation software runs under Microsoft Windows and follows
the standard Windows user interface (see the Microsoft Windows
User's Guide). Starting BIAsimulation presents a menu screen for the
simulation modules:

= BlAsimulation -
File

BlAsimulation

75
Basic Kinetics
Heterogeneous ligand
R ‘
L

Concentration Analysis

Epitope Mapping

Multi-Site Binding

Heterogeneous analyte

Choose a module by clicking on the appropriate button.

For each module, the BIAsimulation screen has a menu bar and a
number of regions which varies according to the simulation module
(Figure 1-1).

BIAsimulation Software Handbook
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= BlAsimulation - Basic Kinetics
File Plot Mode Evaluate Examples Preferences Help
Response (RU) Sensorgram In dR/dt In dR/dt vs Time
2200 3
2000 5
1800
1600 !
1400 ]
1200 T e
1000
800 -
600 -3
] B0 120 180 240 300 3E0 420 480 540 BO0 GEO 0 30 B0 90 120 150 180 210 240 270 300
Time [seconds) Time (seconds)
rReactant Properties | [ Experimental Parameters
ki kd (nM)
a P .
(M1 5-1)  (s-1) Conc. Preinjection Delay (s)
—_— X1 [1es J[1e3 ][5 \
- Association Time (s)
Kz [1es  |[1e3 |[10 |
K3 [ies |[les |[e0 ‘ Dissociation Time (s)
= B4 [1es Jlted o0 | Rmax () 1000 ] ]
— 85 i s o [

Bulk Resp. (RU): D

‘Reset All

Figure 1-1 . Example of a BIAsimulation screen (example for basic kinetics),
showing the common screen components.

Common to all modules is a sensorgram window, input fields for
experimental parameters and control buttons for running the
simulation. Other components are specific to the different modules
(e.g. data plotting windows for kinetics, interaction matrix for epitope
mapping). In addition to standard Windows techniques, the following
features apply:

* in a sensorgram or plot window, double-click with the left mouse
button to open a dialogue box for setting the display scale:

= Sensorgram - Scale I

X Scale ] 'Y Scale
(] 4
DAutu—ﬁ DAutu—i
Cancel
Min: Min:

e e

* in a sensorgram or plot window, double-click with the right mouse
button to enlarge the sensorgram or plot to fill the BIAsimulation
window. Double-click again with the right mouse button to restore
the original display.
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* in a sensorgram or plot window, zoom a selected area by holding
down the left mouse button and dragging over the area to be
enlarged. Single-click with the right mouse button anywhere in the
window to return to the original display.

* in data input areas, click with the right mouse button on text
elements for short help on the respective element. Help is only
implemented on selected elements.

¢ all times are entered and displayed in simulated seconds. The
simulation speed depends on the performance of your computer.

* numerical values may be specified in exponential or ordinary
decimal notation: “5e-4” is equivalent to 0.0005 (=5 x 104).

Only one module can be run at one time. To close a module, double-
click on the system menu button at the top left of the module menu
bar or choose File:Close . To close BIAsimulation, double-click on the
system menu button at the top left of the menu bar or choose File:Quit
from the start-up screen.

Note: The size of the BIAsimulation screen is fixed. You can reduce
BIAsimulation to an icon on the Windows desktop from the
start-up screen, but not from any of the module windows. You
must close a module before you can use the menu bar on the
start-up screen.

Printer setup

BIAsimulation software uses the current printer as defined in the
Windows Control Panel. To change printer settings, open the Control
Panel in Windows Program Manager and double-click on the Printers
icon. Refer to the Windows User Guide and your printer
documentation for setup facilities.

Choose Preferences:All Curves Black  in the current BIAsimulation
module if your printer does not reproduce coloured lines satisfactorily.
This will display and print all simulated curves in black. (Most
monochrome printers render colours as shades of grey, but some
printers may produce unsatisfactory results for light colours.)

BIAsimulation Software Handbook
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2. Basic kinetics

The basic kinetics module simulates up to 5 sensorgrams per session,
with the following features:

* user-defined association and dissociation rate constants
* user-defined bulk contribution to the signal
* user-defined analyte concentration, R;;,,, and injection times

* random error generator within a user-defined interval for analyte
concentration

* adjustable signal noise, averaging window and baseline drift

* independent cooperativity factors for association and dissociation
* steric hindrance

¢ simulation of mass transport limitations

* display of sensorgram and plots of dR/dt against R, In(dR/dt) against
t and dissociation plot

* evaluation of simulated results in terms of kinetic constants
The basic kinetics module can be used in basic or extended mode.
Extended mode allows parameters for noise, drift, concentration error

etc to be set by the user, and allows simulation of mass-transport
controlled binding.

2.1 Theoretical background

The theory of kinetic analysis with real-time BIA is discussed in detail
in the BIAtechnology Handbook, Chapter 8. Equations used in the
basic kinetics simulation are as follows (these equations are also
summarized under Help:Formulae in BIAsimulation):

BIAsimulation Software Handbook 2-1
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2.1.1 Rate equations

Association phase
dR
—=k,C (R
de ? (

max

-R)-k R

where dR/dt is the rate of change of the SPR signal
C is the concentration of analyte
Rinayx is the maximum analyte binding capacity in RU
and R, is the SPR signal in RU at time t

Integrating with respect to time gives

k,CR,. Q _ e—(kaC+kd)t Q

R, =
' k,C+ky

+R0

where R is an integration constant representing the baseline signal.

The association phase is analyzed in terms of two plots (see the
BIAtechnology Handbook, Chapter 8 for details):

dR/dt against R gives slope -(k,C+ky)
intercept k,CR;,,x at dR/dt=0

In(dR/dt) against t gives slope -(k,C+ky)
intercept In(k,CR.y) at In(dR/dt)=0.

Dissociation phase

dR
—=-k R
dt d

Integrating with respect to time gives

R
|”i:kd(t't1)

where R; is the response at time t
and Ry is the response at an arbitrary starting time tq

The dissociation phase is analyzed in terms of a plot of -dR/dt against
R (the “dissociation plot”) which has a slope of k.

2-2 BIAsimulation Software Handbook
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BIAsimulation does not take account of possible rebinding of analyte
during the dissociation phase unless mass transport limitations are
included (rebinding only occurs if the free analyte concentration at the
surface is not zero).

2.1.2 Cooperativity and hindrance
Cooperativity in association or dissociation is simulated by modifying
the respective rate constant according to

R 0O
g
U R hax O

where A is the cooperativity factor (A>0 for positive cooperativity and
A<0 for negative cooperativity). A value of zero indicates no
cooperativity.

Steric hindrance is simulated by reducing the number of available
ligand sites as association progresses. With no hindrance, the amount
of free ligand on the surface at any time is given by (R,ax-R). To
simulate steric hindrance, this term is replaced by (Ry,3-B-R), where B
is the hindrance factor (B=0). A value of 1 indicates no hindrance.
Negative values indicate enhancement (“negative hindrance”).
Hindrance is not relevant during dissociation.

The rate equation incorporating cooperativity in both association and
dissociation and steric hindrance in association is given by

0 0 0 0
R, TeA, R HC Ry ~BR)—ky T+ Ay -3 R
dt R nax O R maxd

2.1.3 Mass transport

Under most conditions, the rate of formation of surface-bound
complex will be limited by mass transport of analyte to the surface. An
approximation to the rate equation which takes mass transport
limitations into account is given by

dR _ kaC(Rmax _R) _de

de G(R pax ~R)
*  MIC

1+k

where G is a factor for converting response to surface concentration
and  MTC is the mass transport coefficient, given by
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where D is the analyte diffusion coefficient (m?/s)

f is the volumetric flow rate (m3/s)
and h, w, | are the flow cell dimensions (height, width, length in
m)

Note that the mass transport-limited rate equation, in contrast to the
interaction-limited equations, requires a factor for converting response
in RU to surface concentration. This is because the rate of mass
transport is related to the absolute analyte concentration. In
BIAsimulation, this factor is assumed to be constant at 1 RU =

1 pg/mm?.

Mass transport is also governed by the diffusion constant of the
analyte. Since this value is often unknown for biomolecules,
BIAsimulation calculates an approximate diffusion constant based on
entered values for the molecular weight, friction factor (asymmetry)
and solvent viscosity.

2.2 Running basic kinetics

2-4

To run a basic kinetics simulation, choose the Basic Kinetics button
from the BIAsimulation main menu. This starts the basic kinetics
application with default values for all parameters.

= BlAsimulation - Basic Kinetics
File Plot Mode Examples Preferences Help

Response (RU) Sensorgram In dR/dt In dR/dt vs Time
2200 3

2000 5

1800

1600 !

1400 0

1200
1000
800
600

-3
] B0 120 180 240 300 3E0 420 480 540 BO0 GEO 0 30 B0 90 120 150 180 210 240 270 300

Time [seconds) Time (seconds)
rBeactant Properties————————— ] " Experimental Parameters
(nM)

(le;as_n (I;_dn Conc. Preinjection Delay (5)

— E‘; “: H:Z an } Association Time () 300
K3 [ies |[les |[e0 ‘ Dissociation Time (s)[300 |
— R4 [o5_Jflea [0 ] S T ]
— [ds [1es  |[1e3 |[a0 | :I

Bulk Resp. (RU): D
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The instructions below summarize briefly how to use the main features
of basic kinetics simulation. Refer to the menu descriptions below for
details.

* To run the simulation with default parameters, simply click on Run.
The sensorgrams for the five reactant properties will be generated in
the sensorgram window. During association, the plot window shows
In(dR/dt) against t by default: you can change this to dR/dt against R
by selecting the appropriate plot from the Plot menu. During
dissociation, the plot window shows the dissociation plot by default.
Choose Plot:Show all to view the sensorgrams and all plots
simultaneously.

* During a simulation, click Pause to pause the simulation or Stop to
end the simulation. If a simulation is paused, the Pause button
changes to Continue : click on this button to resume simulation.

* To change reactant properties (rate constants and/or analyte
concentration), enter the appropriate values in the Reactant
Properties frame. Default values for some typical situations can be
chosen from the Examples menu.

* To change the duration of the simulation, enter the appropriate
values under Experimental Parameters

* To change the other experimental parameters, first choose
Mode:Extended Mode and then select the appropriate option from
the Parameters menu. See below (Section 2.5) for details.

* To simulate mass transport-limited kinetics, first choose
Mode:Extended Mode then select Mode:Mass Transport . You can set
the parameters for mass transport limitation with the
Parameters:Mass Transport option (see Section 2.5.1 for details).
BIAsimulation will calculate both interaction-limited and mass
transport-limited kinetics, generating the latter as overlay curves in
all plots. Note that you set mass transport parameters and choose
curve generation from separate menus. Mass transport-limited
curves will not be generated unless Mode:Mass Transport is checked.

* To restore all parameters to default values, click on Reset all . This
will also restore the mode from Extended Mode to Basic Mode .

* To ignore any user settings for mass transport and other parameters,
choose Mode:Basic Mode . BIAsimulation will then calculate
sensorgrams for default parameter settings with no mass transport
limitations.

* When a simulation is complete, you may choose Evaluation from the
menu to calculate rate constants from the simulated curves. (These
may differ from the constants entered under Reactant Properties  if

BIAsimulation Software Handbook 2-5
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2-6

for example mass transport limitations, noise, baseline drift or
cooperativity are included.)

¢ To print the simulation, choose File:Print . You may choose to print a
2-page summary or selected parts of the simulation.

¢ If you want to use the simulated sensorgram data in another
application, choose File:Export Sensorgrams . The data will be
exported as RU-time coordinate pairs to a tab-separated text file.

2.2.1 Reactant properties
~ Reactant Properties

(nM)
ka kd
(M-1s-1) (s-1) Conc.

—_— X1 [1e5  |[1e3 |[5
Bz [1e5  |[1e3 ||10

— 4 [1e5  |[1e3 |[40

|
|
K13 [1es  |[1e3 |[20 |
|
|

— 5 [1e5 |[1e3 |[80

Bulk Resp. (RU): [0 |

In the Reactant properties frame, enter association and dissociation
rate constants and analyte concentration and check the boxes for all
simulations you wish to perform (up to 5 simulations per run). The

following units are used for the parameters:

association rate constant Mgt
dissociation rate constant s!
analyte concentration according to

Preferences:Concentration Units

Bulk Resp. (RU)

Enter a value for bulk refractive index contribution in RU if desired.
The same contribution will be used for all simulations. The bulk
contribution is simulated as an instantaneous shift in the sensorgram
which does not affect the evaluation of kinetic constants. In real
experiments, a significant bulk contribution distorts the sensorgram
for a few seconds at the beginning and end of the injection.

Note: In extended mode (see Section 2.6.2), the reactant properties
frame also displays the actual analyte concentrations used for
simulation. These may deviate from the entered concentrations
if a concentration error is used (see Section 2.5.4).

BIAsimulation Software Handbook
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2.2.2 Experimental Parameters

 Experimental Parameters

Preinjection Delay (s)
Association Time (s)
Dissociation Time (s)

Rmax (RU)

Preinjection Delay

Enter the time between the start of the sensorgram and injection of
sample. Use this delay to displace the time of injection from the
response axis.

Association Time
Enter the duration of the injection.

Dissociation Time
Enter the time for which dissociation will be simulated (i.e. the time
from the end of the injection to the end of the sensorgram).

Rmax
Enter the analyte binding capacity of the surface in RU.

Other parameters

In extended mode (see Section 2.6.2), the experimental parameters
frame also displays values for other parameters (noise, drift,
cooperativity etc). These parameters are set using commands in the
Parameters menu (see Section 2.5).

Note: All times are entered in simulated seconds.

BIAsimulation Software Handbook 2-7
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2.3 The File menu

Export Sensorgrams...

Print...

Close

2-8

2.3.1 EXxport Sensorgrams

Exports data from simulated sensorgrams as tab-separated text files
containing RU-time coordinate pairs. Data in tab-separated text files
can be imported to BIAevaluation software and to many other
software packages such as spreadsheets and data analysis programs.

Enter a file name for the exported data in the dialogue box.

File Name: Directories:
|kinsimLt)cl | c:\biasim
1 Ee -
= biasim
+ +
Save File as Type: Drives:
[Text Files (*.bd) ] [E= [+]

Notes: Reactant properties and experimental parameters are not
exported with the sensorgram data. If you want to use the
export function for full documentation of your simulation,
make a separate note of the parameter values. The easiest way
to do this is to use File:Print to print all relevant data.

2.3.2 Print

Prints a summary or selected parts of the simulation.

Oﬁummary

@ Full page [JTables

OK

Cancel

@ Sensorgram
@Qissuciatiun plot

D dR/dT vs Response plot
B4 In(dR/dt) vs Time plot
(0

DM&SS Transport
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Summary
If the Summary button is checked, BIAsimulation will print a 2-page
summary of the simulation.

Full page

If the Full page button is checked, BIAsimulation will print one page
for each of the items marked. The Evaluation item cannot be printed
unless a simulation has been performed.

2.3.3 Close

Closes the basic kinetics application and returns to the BIAsimulation
main menu. You cannot close the application if a simulation is
running or paused.

2.4 The Plot menu

Plot

Show All

In dRidt vs Time
dRidt vs Response
Dissociation Plot

Use options in this menu to control which plots are displayed. By
default, BIAsimulation displays a plot of In(dR/dt) against t during
association and a dissociation plot during dissociation.

The sensorgram and plot panels can be enlarged to fill the whole
BIAsimulation window by double-clicking in the respective panel with
the right mouse button. Double-click again in the enlarged panel to
restore the original display.

2.4.1 Show all

Displays four panels simultaneously with sensorgram, dR/dt against R,
In(dR/dt) against t and dissociation plot. Reactant properties and
experimental parameter frames are not shown.
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= BlAsimulation - Basic Kinetics
File Plot Mode Evaluate Examples Preferences Help
dR/dt dR/dt vs Response In dR/dt In dR/dt vs Time In(R1/Rt)  Dissociation plot
3 0.35
1" , 03
9 0325
7 1 0z
015
’ o 0.1
3
g |0
T 1]
4 -2
-0.08
-3 -3 0.1
-0 190 390 590 FS0 990 1190( O 30 80 90120 180 240 300 0 306090 150 210 20
Response (RU) Time (seconds) Time (geconds)
Response (RU) Sensorgram
2200
2000
1800
1600
1400
1200
1000 +
800
600
0 B0 120 180 240 300 360 420 480 540 600 660 = —
Time (seconds) ‘Reset All.

To restore the original display, choose Plot:Show all again.

2.4.2 In(dR/dt) vs Time
Displays a plot of In(dR/dt) against t for the association phase.

2.4.3 dR/dt vs Response
Displays a plot of In(dR/dt) against t for the association phase.

2.4.4 Dissociation plot
Displays a plot of In(R1/R;) against t for the dissociation phase.
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2.5 The Parameters menu

Parameters

Mass Transport...

Noise & Drift...
Cooperativity & Hindrance...

Loncentration Error...

Use options in this menu to set values for determining mass transport
limitations and for the experimental parameters instrument noise,
baseline drift, baseline drift, cooperativity, steric hindrance and
concentration error.

This menu is only available in extended mode (see Section 2.6.2).

2.5.1 Mass transport

Choose this option to set parameters which determine mass transport.
To simulate kinetics with mass transport limitations, check
Mode:Mass transport

= BlAsimulation - Basic Kinetics - Mass Transport Parameters

Approximative Estimation of Mass Transport Influence

~Instrument Parameters  Calculated values

Flow Cell Dimensions:

Length (mm):
Width (mm):
Height {(mm): 3.17

{microliters/minute)

Linear flow (m/s):

6.67E-03

Cell volumes/second:

Diffusion constant:
(m2/s)
8.24E-11

Mass transport coefficient

Solvent properties (MTC)
. . . 1.106E-05
Relative viscosity:
Analyte Properties
Molecular Weight. |50000
Friction factor: E ‘ Help ‘ | OK | | Cancel |

Instrument parameters

Enter the flow cell dimensions in mm in the appropriate fields. The
default values are the dimensions of the standard flow cell in BIAcore
and BIAlite. If you change the dimensions, you can reset the default by
clicking on the Set default button.

Enter the volumetric flow in the Flow field. BIAsimulation will
calculate the flow in terms of linear flow and cell volumes/s when you
click on Calculate .
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2-12

Solvent properties
Enter the viscosity of the bulk solution relative to that of water at
20°C. The default value of 0.89 applies for water at 25°C.

The viscosity factor is necessarily an approximation, since the viscosity
of the surface matrix on the sensor chip is unknown and will probably
vary with the amount of ligand and analyte bound. You may wish to
experiment with high viscosity values (e.g. 2-5) in the simulation to see
the effect on mass transport limitations in media like blood plasma
and other biological fluids.

Analyte properties

Enter the analyte molecular weight and friction factor (asymmetry
factor) in the appropriate fields. If you do not know the friction factor,
the default value 1.2 is suitable for most globular proteins.
Asymmetrical molecules have a higher friction factor.

BIAsimulation will calculate an approximate diffusion constant based
on the analyte and solvent properties when you click on Calculate .
Click with the right mouse button (help function) on the text
“Diffusion constant” to see the formula used for calculating the
diffusion constant.

Note: If you change the analyte molecular weight, you should
change the value of R, accordingly in the Experimental
parameters frame (see Section 2.2.2 above) to retain the same
number of surface binding sites. The value of R, in relation
to the molecular weight reflects the amount of immobilized
ligand, which is one of the experimental factors influencing
mass transport limitation (see BIAtechnology Handbook,
Chapter 5). For example, if you change the molecular weight
from 50,000 to 100,000, you should double the value of R,y.

Calculate
Click on Calculate to apply any changes you have made. The
following parameters are calculated and displayed:

Linear flow from flow cell dimensions and
volumetric flow rate

Cell volumes/s from flow cell dimensions and
volumetric flow rate

Diffusion constant from analyte molecular weight and
friction factor and solvent viscosity

Mass transport coefficient ~ from cell dimensions, diffusion constant
(see Section 2.1.3) and flow rate
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If you have made changes to any of the parameters, you must click on
Calculate to use the changes in kinetic simulation. If you do not want
to use the changes, click on Cancel.

2.5.2 Noise and Drift
Choose this option to simulate noise and baseline drift in the
sensorgram.

= BlAsimulation - Extended Mode - Noise and Drift

MNoise

Enter a value in the range 0 to 3 RU.
Noise will be generated randomly in
the range +/- the value entered.

]

Aweraging window

Enter a time interval >= 1 second
over which response averaging
will be done.

]

=
=h
=

Enter a drift value in in the range
-0.1to 0.1 RU/second.

|

| 0K I | Cancel

Noise

Noise is simulated as random fluctuations within the interval you
specify in the dialogue box (up to +3 RU). Noise may not be very
apparent on the sensorgram, but can have a dramatic effect on plots of
dR/dt against R and In(dR/dt) against t, particularly as the sensorgram
flattens out. Noise can affect the accuracy of simulated evaluation.

To turn noise off, set a value of 0 in the dialogue box.

Note: Typical noise values for experimental sensorgrams are
< 2 RU for BIAcore and BlAlite and < 0.3 RU for
BIAcore 2000.

Averaging window

The averaging window can be set to a value higher than 1 to smooth
noise fluctuations. A suitable value is in the range 1-10 s. The
averaging window affects only noise, not the simulated signal.

The averaging window setting is irrelevant if noise is set to O.
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Drift

Enter a value for the baseline drift in RU/s (range -0.1 to 0.1). The
baseline drift will be applied as a constant value throughout the
simulated sensorgrams.

Note: The drift is specified in RU/s. Baseline drift in experimental
sensorgrams is typically <0.3 RU/min (<0.005 RU/s) for
BIAcore, BIAcore 2000 and BIAlite with active temperature
control, and <1 RU/min (<0.017 RU/s) for BIAlite with passive
temperature control.

2.5.3 Cooperativity and Hindrance
These parameters are used to simulate cooperativity and hindrance
during association and dissociation:

 Cooperativity alters the binding affinity according to the number of
ligand sites occupied.

» Hindrance alters the number of available sites in relation to the
number of ligand sites occupied.

] BlAsimulation - Extended Mode - Cooperativity and Hindrance

Association cooperativity

Enter a value {Aa) to indicate whether the association rate constant
will increase or decrease with an increasing response. kass will now
depend on the response according to:

ka (app) =ka (1 + Aa™R/Rmax)

Aa = The default value is 0.

Dissociation cooperativity

Enter a value {(Ad) to indicate whether the dissociation rate constant will
increase or decrease with an increasing response.kdiss will now depend on
the response according to:

kd (app) = kd {1 + Ad * R/Rmax )

Ad = E The default value is 0.

Hindrance

Enter a value >=0 to indicate whether each binding event will block more
than one site. Remaining free binding sites will now depend on the
response according to:

(Rmax-R) (app) = (Rmax-B*R)

B-= I:I The default value is 1.

0K I | Cancel
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Association cooperativity
Enter a factor to represent cooperativity in analyte-ligand association.
The rate equation will be modified accordingly (see Section 2.1.2).

A value of 0 indicates no cooperativity. Positive values indicate
positive cooperativity (binding is tighter as more sites are occupied)
and negative values indicate negative cooperativity (binding is weaker
as more sites are occupied).

The association cooperativity factor modifies the association rate
constant in relation to the fraction of sites occupied. Do not confuse
negative cooperativity with steric hindrance (see below), which
modifies the number of sites available in relation to the fraction of
sites occupied.

Dissociation cooperativity
Enter a factor to represent cooperativity in analyte-ligand dissociation.
The rate equation will be modified accordingly (see Section 2.1.2).

A value of 0 indicates no cooperativity. Positive values indicate
positive cooperativity (dissociation is faster as more sites become free)
and negative values indicate negative cooperativity (dissociation is
slower as more sites become free).

Hindrance

Enter a factor to represent steric hindrance during association. The
number of remaining free sites will be modified accordingly (see
Section 2.1.2).

A value of 1 indicates no hindrance. Values above 1 indicate steric
hindrance: e.g. if a value of 2 is used, the number of available ligand
sites is reduced by 2 for each analyte molecule bound. Values less than
1 mean that each analyte molecule bound occupies effectively less than
one ligand site (i.e. binding one analyte molecule exposes additional
ligand sites).

Hindrance affects only the association phase.

2.5.4 Concentration Error

Enter a value for random error in analyte concentration, up to 20%.
The analyte concentration used for simulation will be that specified in
under Conc in the Reactant properties frame (see Section 2.2.1) plus
or minus a random error up to the percentage specified (e.g. if the
concentration is specified as 10 nM and the error as 20%, a random
value in the range 8-12 nM will be used). The concentration used is
shown under Reactant properties when the simulation starts.
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= BlAsimulation - Extended Mode - Concentration Error
Concentration error
I:l Enter a value in the range 0 to 20. A
random concentration error in %%
within +/- the entered value will be
generated for each concentration.

(0] % I | Cancel I

2.6 The Mode menu

Mode
Extended Mode |
[hasic modei

!

Mode

Mass Transport
Basic Mode

fextended miodef
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The Mode menu switches between basic and extended mode and
controls which parameters are used in simulating sensorgrams.

2.6.1 Basic Mode

In basic mode, any user settings for mass transport, noise and drift,
cooperativity and hindrance and concentration error are ignored.
Sensorgrams are simulated using the following settings, with no mass
transport limitations:

* noise 0
averaging window irrelevant
drift 0
association cooperativity 0
dissociation cooperativity 0
hindrance 1
concentration error 0

BIAsimulation starts by default in basic mode. If the mode is set to
extended, choose Mode:Basic Mode to return to basic mode. Any
extended mode parameter settings will be retained. You can also click
on the Reset All button, which will reset all extended mode parameters
to default values and switch to basic mode.

2.6.2 Extended Mode

In extended mode, simulation will take account of noise and drift,
cooperativity and hindrance and concentration error parameters. Mass
transport limitations can also be simulated.

When BIAsimulation is in extended mode, the Parameters settings and

the effect of concentration error are shown in the experimental
parameters and reagent properties panels respectively:
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 Reactant Properties Experimental Parameters =
ka kd ("M) ___________ Preinjection Delay (s) |60
(M-15-1) (s-1) Conc. . Error Conc. Association Time (s) [300
—_ |1E5 H1E'3 ||5 | 4.814 Dissociation Time (s) (300
Kz [1es  l1e3 |10 |i 98m Rmax (RU) 1000
(43 [1e5  |[1e3 |[20 |} 2008 |1 Noise Level (+/JRU- 15
Averaging Window (s): 10
— — 38.86 ging
(4 [tes |1e3 |40 | : Drift (RU/s): 0.005
—— [5 [1e5 |[se-3 |[s0 | i 77.688 Ass. Coop. (A): .3
Hindrance (B): 2
BulkResp. (RU): [0 | MaxEm (%) 5 :
Y esp- (RU): ax Err. (%) Diss. Coop. (C): 0

BIAsimulation starts by default in basic mode. Choose Mode:Extended
Mode to select extended mode.

To simulate mass transport limitations, choose Mode:Extended Mode
and then Mode:Mass Transport . When the option is checked, each
interaction is simulated both with and without mass transport
limitations. The sensorgram without mass transport (interaction-
limited kinetics) is shown in colour and the mass transport-limited
sensorgram as an overlay in black. This is illustrated below for a single
sensorgram, with the coloured (interaction-limited) sensorgram shown
as a dashed line:

Response (R Sensorgram
3500 -

3000 4
2500 4
2000 4

] t } t t t t t } t } !
] B0 120 180 240 300 360 420 480 540 BOOD  GBRO
Tirme (seconds)

We recommend that you run mass transport overlays on one or two
interactions at a time. If several simulations are performed in one run,
it may be difficult to relate the mass transport overlays to their
respective interaction-limited sensorgrams.

During simulation, the effect of mass transport limitations is displayed
to the right of the Experimental Parameters frame as the mass
transport-influenced binding rate expressed relative to the rate that
would be obtained in the absence of mass transport:
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Mass transp.
influenced
binding rate
relative to
pure kinetics

0.858

This ratio is always less than or equal to one (mass transport
limitations reduce the observed binding rate). The ratio is updated
continuously as the simulation progresses. The value shown at the end
of the simulation applies to the last point in the last sensorgram.

If you want to change the mass transport limitation parameters,
choose Parameters:Mass Transport and enter the required settings (see
Section 2.5.1). Remember to click on Calculate in the mass transport
parameters dialogue box to implement the changed settings.

2.7 The Evaluate menu

Evaluate
Evaluate...

2-18

Use the option in this menu to calculate kinetic constants from the
simulated sensorgrams. As long as mass transport limitations, noise,
cooperativity etc are not included, the results of evaluation should be
identical to the constants entered under Reactant properties . The
evaluation facility is however valuable in assessing the impact of the
various experimental parameters on the final result of a kinetic
determination.

The evaluation facility can only be used after completion of a
simulation.
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2.7.1 Evaluate

O Fit to Dissociation Phase C{nM) Start Time End Time Slope Intercept
-1.7305E-03 9.6419E-D1
@ Fit to In(dR/dt) vs Time —1[5 | [1 | [s00 |
O Fit to dR/dt vs Response 2 |”:I | |‘I ‘ |5|:":I | -2.6255E-03 1.6137E+00
[IFi e Mase Transpost Data 3 |2|:I | |1 ‘ |5|:||:I | S.113E-03 2.4082E+00
I Plot Data ] |4|] | |1 ‘ |5nn | -1.187E-02  3.3915E+00
| Calculate Fit I | Ftop I —b |B[I | |1 ‘ |5[I[I | -1.5248E-02 3.1007E+00
In{dR/dt) In{dR/dt) vs time plot Final Results ——————————
1
Calculate Constants
32
2.4 Slope:
16 Intercept:
a8 ka (M-1s-1):
1]
kd (s-1):
08 (s-1)
AR Ka (M-1):
24 Kp (M)
-32
-4

0 60 120 180 240 300 360 420 430 54D 60O Help | Close |

Time (seconds)

The Evaluate dialogue box is filled in by default with the nominal
concentrations and start/end times for the association phase of the
most recent simulation. To calculate rate constants:

1. Choose the curve to fit. Both association and dissociation rate
constants are derived from the association phase, using either
dR/dt vs R or In(dR/dt) vs t (see the BIAtechnology Handbook,
Appendix A, for a discussion of the relative merits of these plots).
Only dissociation constants are derived from the dissociation
phase.

2.  Check Fit to Mass Transport Data if you have included mass
transport in the simulation and wish to evaluate on the basis of
the mass transport data.

3. Check Plot data if you want to display the curve fitting
graphically. This will slow down the evaluation process, but can
give valuable information concerning deviations from ideal
behaviour (e.g. noise, drift and mass transport limitations).

4. Click on Calculate Fit . BIAsimulation will calculate a linear least
squares regression fit for the selected plots. If Plot Data is
checked, the fit is displayed directly in the graph frame. You can
enlarge and zoom this frame using the same techniques as for
other graph frames (see Section 1.2).
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For association plots, the slope (= -(k,C+kq)) and intercept

(= kaCRypax or In(k,CR;.y)) are listed as each plot is fitted. When
the curve fitting is complete, click on Calculate Constants in the
Final Results frame. (At least two concentrations must be
simulated to use this function.) The calculated constants are
displayed together with a plot of slope against C.

Slope™-1) Slope vs conc plot Final Results
0.025
ooz Slope: 0.000188
o015 @ Intercept: 0.001504
© ka (M-1s-1): 1.88E+05
0.m
kd (s-1): 1.50E-03
Se-3 Ka (M-1):1.25E+08
T
o ° K (M):8.00E-09
-5e-3 + + + + + + + + + t t 1
0 g 16 24 32 40 48 86 B4 72 80 88 56 Help I Close I
C (i)

For dissociation plots, the slope of the plot is -k4 and the intercept
is theoretically zero. These values are displayed as each plot is
fitted. The Calculate Constants button is not available for
dissociation plots, since only k4 can be obtained.

5. If you wish to use only part of the association or dissociation
phase to calculate constants, change the values under Start Time
and End Time . These times apply to the association or
dissociation phase according to which fit is selected, and are
measured from the beginning of the phase (not in absolute
simulated seconds). This is particularly useful in analysing mass
transport-limited kinetics, where interaction-limited association
may only be observed in the later phases of association.

Printing evaluation results

If you choose File:Print after performing an evaluation, you may
choose to print the evaluation results under the Full page option (see
Section Section 2.3.2). The printout will contain the results for the
most recent evaluation. To print evaluation for both association and
dissociation phases, evaluate one phase, print the results, then evaluate
the other phase and print again.
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2.8 The Examples menu

Examples

¥ Same kasstkdiss Different Concentrations
Same kassiDifferent kdiss
Same kdiss/Different kass

Same Affinity - Different kass and kdiss

Use the options in the Examples menu to set default reactant property
values for typical scenarios as specified below. The examples can only
be used in basic mode. To run an example set of values in extended

mode, choose the example in basic mode and then switch to extended

mode.

2.8.1 Same kass/kdiss, different Concentrations
This is a typical concentration series for determining kinetic constants
for a single interaction pair.

Run k, (M-1s1) kg (s K (M) Conc (nM)
1 10° 1073 108 S
2 10° 1073 108 10
3 10° 1073 108 20
4 10° 1073 108 40
5 10° 103 108 80

BIAsimulation Software Handbook
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2.8.2 Same kass, Different kdiss

The concentrations in this series are equal to the Kp values, which give

steady state saturation levels equal to Ryj,/2.

Run k, (M-1s1) kg (s K (M) Conc (nM)
1 10° 102 107 100
2 10° 5-10°3 5108 50
3 10° 103 108 10
4 10° 5-10 5108 S
S 10° 10+ 107 1

2.8.3 Same kdiss, Different kass

The concentrations in this series are equal to the Kp values, which give

steady state saturation levels equal to Ryj,/2.

Run k, (M-1s1) kg (s K (M) Conc (nM)
1 10% 1073 107 100
2 5-104 1073 2-108 20
3 10° 103 108 10
4 5-10° 1073 2-10° 2
S 106 1073 107 1

2.8.4 Same Affinity, Different kass/kdiss

The concentrations in this series are equal to the Kp values, which give

steady state saturation levels equal to Ry,/2.

Run k, (M-1s1) kg (s K (M) Conc (nM)
1 10% 10+ 108 10
2 5-104 5-10 108 10
3 10° 103 108 10
4 5-10° 5-10°3 108 10
S 106 102 108 10
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2.9 The Preferences menu

Preferences

Concentration Unit...
All Curves Black

2.9.1 Concentration Unit
This setting determines the unit in which concentrations are to be
entered in BIAsimulation.

= Concentration Unit Selection

Do not use exponents (e.g. 5e-9) for
concentration value denominator inputs.

Instead. for the abowve example. enter
5 and select nM.

) nanomolar {nM])

®

O millimolar {mM)

O molar (M)

Choose the concentration unit you prefer to use. You can enter
concentration values using exponent notation if you wish (e.g. 5e-3
means 5 x 10-3): the values will be interpreted in terms of the current
concentration unit setting. The following entries are thus equivalent
(and represent 5 pM):

Concentration unit Value

nanomolar (nM) 5000 (or Se3)
micromolar (uM) 5

millimolar (mM) 0.005 (or 5e-3)
molar (M) 0.000005 (or Se-6)

The concentration unit setting is global and applies to all
BIAsimulation modules.

Note: The concentration unit setting applies only to entry of
concentration data. Rate and equilibrium constants are always
specified on a molar basis.
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2.9.2 All Curves Black

Choosing this setting displays all curves in black. Use this setting if
you want to print simulation results on a printer which does not
handle colours satisfactorily.

Note: Changing this setting affects subsequent simulations but does
not change the display of the current simulation.

2.10 The Help menu

Help

Help...

Formulae...

Mouse Functions...

2-24

2.10.1 Help

In general, click with the right mouse button on a text area to display
help for the item (e.g. click on Bulk Resp. (RU) in the Reactant
properties frame for help on this parameter). This works on all text
which serves to identify an input or display field.

2.10.2 Mouse Functions
This command displays a summary screen of mouse operations,
including a small sensorgram display for practice.

2.10.3 Formulae
This command displays a summary screen showing the formulae used
in simulating basic kinetics (see Section 2.1).
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3. Heterogeneous ligand kinetics

This application simulates binding kinetics for a single analyte and a
heterogeneous ligand, with up to 3 different ligand species for which
association and dissociation constants are specified separately.
Simulation may be run for a single analyte concentration, a series of
analyte concentrations or as an overlay of two simulations with
different analyte concentrations and/or ligand properties.

Heterogeneous ligand kinetics are simulated without mass transport
limitations.

3.1 Theoretical background

When the immobilized ligand is heterogeneous, the observed kinetics
are in principle the sum of independent kinetics for the separate
ligands. BIAsimulation generates sensorgrams and plots for
heterogeneous ligands on this basis, using the equations described in
Section 2.1.

3.2 Running heterogeneous ligand kinetics

To run a heterogeneous ligand kinetics simulation, choose the
Heterogeneous ligand button from the BIAsimulation main menu.
This starts the heterogeneous ligand application with default values for
all parameters.
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File

Plot

Preferences

Help

= Blasimulation - Heterogeneous Ligand

Mode

Response (RU)
100
a0
a0
70
1]
a0
40
30
20
1
1)

Sensorgram

In{R1/R)

Dissociation

100
90
80
70
=]
50
40
30
20
10

o
0 10 20 30 40 80 B0 70 80 S0 100

0 100 200 300 400 500 GO0 FOO 800 900 1000
Time (seconds) Tirne (s)
Reactant P Experimental Parameters
. Anal
Ligand : Analyte Preinjection Delay (s)
ka kd Composition Single Concentration o . 200
M-15-1) (s-1) % of Sites | (M) Association Time (s) -
-— |1E5 ‘ ‘19'3 | |3U | Dissociation Time (s)
— [1es | 1e2_ | [0 | Baseline (RU)
[5e4 | [se-a ] [30 |
== Total response H . I
Rmax (RU) ‘ Reset All I | Biop I

The instructions below summarize briefly how to use the main features

of heterogeneous ligand simulation. Refer to the menu descriptions
below for details.

* To run the simulation with default parameters, simply click on Run.
Sensorgrams will be generated to represent the three separate ligand
components and the total response (i.e. the observed sensorgram).
During association, the plot window shows In(dR/dt) against t by
default: you can change this to dR/dt against R by selecting the
appropriate plot from the Plot menu. During dissociation, the plot
window shows the dissociation plot by default. Choose Plot:Show
All to view the sensorgrams and all plots simultaneously.

* During a simulation, click Pause to pause the simulation or Stop to
end the simulation. If a simulation is paused, the Pause button
changes to Continue : click on this button to resume simulation.

* To change ligand properties (rate constants and/or proportions of
the component ligands), enter the appropriate values in the Reactant
Properties frame. Note that the amount of each ligand component is
specified as a percentage of the total ligand. Simulation cannot be
performed if the ligand components do not add up to 100%.

* To change the analyte concentration, enter the required value under
Analyte . See Section 3.3 for generating an analyte concentration

series.

 To change the duration of the simulation, enter the appropriate
values under Experimental Parameters
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* To restore all parameters to default values, click on Reset All.

* When a simulation is complete, you may choose Evaluation from the
menu to calculate rate constants from the simulated curves.

¢ To print the simulation, choose File:Print . You may choose to print a
2-page summary or selected parts of the simulation.

¢ If you want to use the simulated sensorgram data in another
application, choose File:Export Sensorgram s. The data will be
exported as RU-time coordinate pairs to a tab-separated text file.

3.2.1 Reactant properties
rReactant Properties

Ligand Analyte
ka | kd Composition Single Concentration
M1s1)  (s1) % of Sites | {ni)
— [tes  J[tea ][0 i
— [te6 |[lez [0 ] i
[5e4 | [se4 ] [30 |

== Total response

Ao (U

Under Ligan d, enter association and dissociation rate constants and
composition of total ligand for up to 3 ligand components. If you only
want to use two ligand components, set the third component to 0%. In
the Rmax field, enter the maximum analyte binding capacity of the
surface. The following units are used for the parameters:

association rate constant Mgt

dissociation rate constant s!

composition % of total (the sum must be 100%)
Rmax RU

Under Analyte , enter the analyte concentration (units according to
Preferences:Concentration Units ) for a single concentration
simulation. See Section 3.3 for generating an analyte concentration
series.
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3.2.2 Experimental parameters
 Experimental Parameters

Preinjection Delay (s)
Association Time (s)
Dissociation Time (s)

Baseline (RU)

Preinjection Delay

Enter the time in (simulated) seconds between the start of the
sensorgram and injection of sample. Use this delay to displace the time
of injection from the response axis.

Association Time
Enter the duration of the injection in (simulated) seconds.

Dissociation Time

Enter the time in (simulated) seconds for which dissociation will be
simulated (i.e. the time from the end of the injection to the end of the
sensorgram).

Baseline
Enter a baseline value in RU to displace the sensorgram from the time
axis.

3.3 Concentration series

You can simulate a set of up to five sensorgrams for a series of analyte
concentrations with heterogeneous ligand, using concentrations either
specified individually or generated in geometric progression from a
starting concentration. This simulates the commonest approach to
analysing heterogeneous ligand kinetics in experimental situations.

Choose Mode:Concentration Series  and enter the analyte
concentrations in the dialogue box.
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entration Series Yalues

Conc.
Number of Steps {(Max. 5): EI Step  (nM)

Start Conc. (nM): 112

Change FPer Step (-fold): 3
:

5

Cancel

The default setting is a concentration series of 5 steps with a factor of
2 between steps, starting at the concentration currently used for single
concentration simulation. If you change any of the fields Number of
Steps, Start Conc or Change Per Step , you will automatically generate
new concentration values according to the changed settings. You can
also make changes directly in the Conc fields, in which case the
settings for generating the concentration values will be ignored.

In this mode, only the total sensorgram is shown for each analyte
concentration. You can evaluate the results when the simulation is
complete (see Section 3.8).

= BlAsimulation - Heterogeneous Ligand - Concentration Series

File Plot Mode Evaluate Preferences Help

Response (RU) Sensorgram In dRAdt In dR/dt vs Time
2200 5
2000 4
1800 3
1600 2
1400 s |
1200 ]
1000 -1
300 2
500 -3
0 B0 120 180 240 300 380 420 480 540 EBOOD  BEO 0 30 B0 90 120150 180 210 240 270 300
Time {seconds) Time {seconds)
" Beactant Properties N " Experimental Parameters
- H Anal
Ligand : Analyte Preinjection Delay (s)
ka kd Composition H Concentration Series . i
M-1s-1) (s-1) % of Sites (nM) Association Time (s)
‘195 ‘ |1E-3 | 30 | 1 J— Dissociation Time (s)
[1es [[tez ][ | : 2 —_ Baseline (RU)
[5e4 | [se-a ] [30 | 3
: — Mo rt)
Rma (RU) ;s - [Resetai ] [ swp |
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3.4 Overlay plots

3-6

You can generate an overlay plot of two simulations with different
values for analyte concentration and/or ligand mixture, for ease of
comparison between the sensorgrams and plots.

To run an overlay plot, first perform a simulation for a single analyte
concentration. The choose Mode:Overlay Plot and enter the parameters
for the second plot in the dialogue box:

B ocrioymode |
Ligand
Composition
kass kdiss % of Total
[1e5 | [1e3 | [30 |
[1e6 |[1e-2 ][40 |
[5e4 | [se-4 | |30 |
Analyte
Concentration (nM)
‘ OK | ‘ Cancel |

Click on OK in the dialogue box, then on Overlay in the main window
to generate the overlay plot. The component sensorgrams and plots
from the single concentration simulation are cleared, and only the
total curves are shown.

= Blasimulation - Heterogeneous Ligand - Overlay

File Plot Mode Preferences Help
Response (RU) Sensorgram In dR/dt In dR/dt vs Time
1700 3
1600 4
1500 3
1400 P
1300 1
1200 0
1100
1000 -
900 -2
800 -3
0 B0 120 180 240 300 360 420 430 540 GO0 GGED 0 30 B0 90 120 150 180 210 240 270 300
Time (seconds) Time (seconds)
Reactant Properies - Overlay Mode [ Experimental Parameters
Ligand - Original ! Ligand - Overlay Preinjection Delay (s)
kass kdiss % of Total kass kdiss % of Total Association Time (s)
1eb 1e-3 30 » leb 1e-3 30
Dissociation Time (s)
1eb le-2 40 P leb le-2 40
Baseline (RU
5ed be-14 30 . bed 5e-4 30 )
Analyte - Original Analyte - Overlay ‘ Run I | Pruse I
Conc.(nM) 10.0 Conc.(nM) 20 | ‘Reset All. I | pEEETY I
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3.5 The File menu

File |

Export Sensorgrams...

Print...

Close

Commands in this menu are the same as in the File menu for basic
kinetics simulation (Section 2.3).

3.6 The Plot menu

Plot

Show All

In dRidt vs Time
dR/dt vs Response
Dissociation Plot

Commands in this menu are the same as in the Plot menu for basic
kinetics simulation (Section 2.4).

3.7 The Mode menu

' Mode

Single concentration
Concentration Series...
Overlay Flot...

3.7.1 Single concentration

Simulates heterogeneous ligand interaction kinetics for a single analyte
concentration (default mode). Sensorgrams and plots are shown
separately for the component ligands and the total (observed)
response.

3.7.2 Concentration Series

Generates heterogeneous ligand interaction kinetics for a series of up
to 5 analyte concentrations (see Section 3.3). Only the total (observed)
response is shown for each analyte concentration. The simulated
results can be evaluated for apparent rate constants in terms of a
homogeneous interaction model (see Section 3.8).

3.7.3 Overlay plot

Generates an overlay plot of two simulations with different values for
analyte concentration and/or ligand mixture (see Section 3.4). Only
the total (observed) response is shown for each analyte concentration.
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3.8 The Evaluate menu

Evaluate
Evaluate... 3.8.1 Evaluate

This function evaluates a concentration series simulation in terms of
apparent rate constants. The command is only available when a
concentration series simulation has been performed.

The Evaluate function operates in the same way as for basic kinetics
simulation. See Section 2.7 for a description.

Important

Heterogeneous ligand simulations are evaluated as though the
interaction was homogeneous. The function gives the apparent rate
and affinity constants that would be obtained if the data were
analysed according to a homogeneous interaction model.

3.9 The Preferences menu
Commands in this menu are the same as in the Preferences menu for

Preferences basic kinetics simulation (Section 2.9).

Concentration Unit...
All Curves Black

3.10 The Help menu

Help Commands in this menu are the same as in the Help menu for basic
Help... kinetics simulation (Section 2.10).

Mouse Functions...

Formulae...
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4. Heterogeneous analyte
kinetics

This application simulates binding kinetics for a mixture of up to 3
analytes that compete for a single ligand. Association and dissociation
constants are specified individually for the different analytes.
Simulation may be run for a single analyte concentration or for a
series of total analyte concentrations where the proportions of
component analytes are kept constant.

Heterogeneous analyte kinetics are simulated without mass transport
limitations.

4.1 Theoretical background

When the analyte is heterogeneous, the observed kinetics result from
competition of the different analyte species for the same ligand.
BIAsimulation generates sensorgrams and plots for heterogeneous
ligands on this basis. See the BIAtechnology Handbook, Appendix A
for equations.

4.2 Running heterogeneous analyte kinetics

To run a heterogeneous analyte kinetics simulation, choose the
Heterogeneous analyte button from the BIAsimulation main menu.
This starts the heterogeneous analyte application with default values
for all parameters.
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= BlAsimulation - Heterogeneous Analyte

File Plot Mode Preferences Help
Response (RU) Sensorgram Ir R/t In dR/dt vs Time
100 100
a0 a0
80 a0
70 70
B0 B0
a0 a0
40 40
30 30
20 20
10 10
1] u]
o 100 200 300 400 500 BOO 700 8O0 900 1000 0 100200 300 400 500 600 700 800 900
Time (seconds) Time {seconds)
" Reactant Properties - Single Sample  Experimental Parameters
Analyte
Preinjection Del
ka kd MW Rmax C (nM) reinjection Delay (s)
- |195 | |le—3 ‘ |5|]|]|]|] ‘ 5000 Association Time (s)
— [1e6 |[1e-2 |[5000 | 500 Dissociation Time (s)
Sed 5e-4  ||500 50
| | | ‘ | ‘ Baseline (RU) |10000
== Total response
| Bun I ‘ Pouse I | Stop I

Ligand
Rmax for analyte of MW = 10,000 -II :.
Reset All

The instructions below summarize briefly how to use the main features
of heterogeneous analyte simulation. Refer to the menu descriptions
for details.

* To run the simulation with default parameters, simply click on Run.
Sensorgrams will be generated to represent the three separate analyte
components and the total response (i.e. the observed sensorgram).
During association, the plot window shows In(dR/dt) against t by
default: you can change this to dR/dt against R by selecting the
appropriate plot from the Plot menu. During dissociation, the plot
window shows the dissociation plot by default. Choose Plot:Show
All to view the sensorgrams and all plots simultaneously.

* During a simulation, click Pause to pause the simulation or Stop to
end the simulation. If a simulation is paused, the Pause button
changes to Continue : click on this button to resume simulation.

* To change analyte properties (rate constants, molecular weights
and/or concentrations of the component analytes), enter the
appropriate values in the Reactant Properties frame.

» To change the total analyte binding capacity of the surface
(representing the amount of immobilized ligand), enter the required
value for Ry, for an analyte of MW 10,000. Values for Ry, for
the individual analytes are derived from this value together with the
respective analyte molecular weights. Note that the actual R, for
the analyte mixture will be a function of the concentrations,
affinities and individual R, values for the separate analytes.
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* To change the duration of the simulation, enter the appropriate
values under Experimental Parameter s.

* To restore all parameters to default values, click on Reset All.

* When a simulation is complete, you may choose Evaluation from the
menu to calculate rate constants from the simulated curves.

¢ To print the simulation, choose File:Print . You may choose to print a
2-page summary or selected parts of the simulation.

* If you want to use the simulated sensorgram data in another

application, choose File:Export Sensorgram s. The data will be
exported as RU-time coordinate pairs to a tab-separated text file.

4.2.1 Reactant properties

Reactant Properties - Single Sample

Analyte
ka kd MW Rmax C (nM)
— [1e5 |[1e3 |[s0000 | 5000
— [1e6  |[1ez |[5000 ] 500
[sea  |[se-a |[s00 |50

== Total response

Lgand

Rmax for analyte of MW = 10,000

Under Analyte , enter association and dissociation rate constants,
molecular weights and concentrations for the analyte components. If
you only want to use two analyte components, set the concentration of
third component to 0. The following units are used for the parameters:

association rate constant Mgt

dissociation rate constant s!

molecular weight daltons

concentration according to Preferences:Concentration
Units

Under Ligan d, enter the total analyte binding capacity for an analyte
with molecular weight 10,000. BIAsimulation will display the
corresponding Ry values for the individual analytes based on their
molecular weights.
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4.2.2 Experimental parameters

" Experimental Parameters

Preinjection Delay (s)
Association Time (s)

Dissociation Time (s)
Baseline (RU)

Preinjection Delay

Enter the time in (simulated) seconds between the start of the
sensorgram and injection of sample. Use this delay to displace the time
of injection from the response axis.

Association Time
Enter the duration of the injection in (simulated) seconds.

Dissociation Time

Enter the time in (simulated) seconds for which dissociation will be
simulated (i.e. the time from the end of the injection to the end of the
sensorgram).

Baseline
Enter a baseline value in RU to displace the sensorgram from the time
axis.

4.3 Concentration series

4-4

You can simulate a set of up to five sensorgrams for a series of mixed
analyte concentrations. Concentrations are generated in geometric
progression from a starting concentration. If desired, the concentration
of one component can be kept constant while the other components
are varied. This simulates a valuable approach to analysing
heterogeneous analyte kinetics in experimental situations, by adding a
fixed amount of a known (homogeneous) analyte to a concentration
series of the unknown analyte mixture.

Note: If you want to simulate the effect on binding a mixture of two
analytes of adding a fixed amount of one of the analytes,
define A and B in BIAsimulation with identical reactant. You
can then keep A constant and generate a concentration series
for B and C.
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Choose Mode:Concentration Series  and enter the analyte
concentrations in the dialogue box.

= Concentration Series Values

Change Per Step (-fold): IZI
Number of Steps (Max. 5): EI

O Keep concentration of A constant

Component
A B c
Cone. @) lo ] [0 | [0 ]
Step 1 100 10.0 10.0
2 200 200 200
3 400 40.0 40.0
4 80.0 80.0 80.0

5 160.0 160.0 160.0

| 0OK I | Cancel I

The default setting is a concentration series of 5 steps with a factor of
2 between steps, starting at the concentration currently used for single
concentration simulation. If you change any of the fields Number of
Steps, Start Conc or Change Per Step , you will automatically generate
new concentration values according to the changed settings.

In this mode, only the total sensorgram is shown for each analyte
mixture. You can evaluate the results (Section 4.7) when the
simulation is complete.
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= Blasimulation - Heterogeneous Analyte - Concentration Series
File Plot Mode Evaluate Preferences Help
Response (RL) Sensorgram In dRVdt In dR/dt vs Time
11000 5
10900 4
10800 s
10700
10600 2
10500 1
10400 0
10300 .
10200
10100 -2
10000 -3+
1) B0 120 180 240 300 360 420 480 540 BOOD 0 30 B0 90 120150 180 210 240 270 300
Time (seconds) Time (seconds)
[ Beactant Properties - Concentration Series— | [ Experimental Parameters —— |
Analyte :
1 Step .
Ka kd MW Rmax G (nM) ] Preinjection Delay (s)
1e5 1e-3 50000 5000 10.0 L Assaciation Time (s)
M=
1eb 1e-2 5000 500 160.0 | i iati i
e e 3 Dissociation Time (5)
Ged 5e-4 500 50 160.0 : 4 —
Baseline (RU) (10000
. [10000 |
Ligand | Bun ‘ | Puwss | ‘ Sop |

Rmax for analyte of MW = 10,000
Reset All

Note: During the simulation, analyte concentrations are displayed
under Reactant Properties  for the sensorgram currently being
simulated. When the simulation is complete, this information
applies to the last sensorgram generated. To review the
concentrations for the other sensorgrams, choose
Mode:Concentration Series and inspect the values.

4.4 The File menu

Commands in this menu are the same as in the File menu for basic
File kinetics simulation (Section 2.3).

Export Sensorgrams...

Print...

Close

45 The Plot menu

Commands in this menu are the same as in the Plot menu for basic
Plot kinetics simulation (Section 2.4).
Show All

In dRidt vs Time
dR/dt vs Response
Dissociation Plot
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4.6 The Mode menu

Mode

Single sample
Concentration Series...

4.6.1 Single sample

Simulates heterogeneous analyte interaction kinetics for a single
analyte mixture (default mode). Sensorgrams and plots are shown
separately for the component analytes and the total (observed)
response.

4.6.2 Concentration Series

Generates heterogeneous analyte interaction kinetics for a series of up
to § analyte mixtures (see Section 4.3). One of the analytes can if
desired be maintained at a constant concentration while the
concentration of the others is varied. Ony the total (observed) response
is shown for each analyte concentration. The simulated results can be
evaluated for apparent rate constants in terms of a homogeneous
interaction model (see Section 4.7).

4.7 The Evaluate menu

Evaluate
Evaluate...

4.7.1 Evaluate

This function evaluates a concentration series simulation in terms of
apparent rate constants. The sum of the individual analyte
concentrations is used in the evaluation. The command is only
available when a concentration series simulation has been performed.

The Evaluate function operates in the same way as for basic kinetics
simulation. See Section 2.7 for a description.

Important

Heterogeneous analyte simulations are evaluated as though the
interaction was homogeneous. The function gives the apparent rate
and affinity constants that would be obtained if the data were
analysed according to a homogeneous interaction model.
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4.8 The Preferences menu
Commands in this menu are the same as in the Preferences menu for

Preferences basic kinetics simulation (Section 2.9).

Concentration Unit...
All Curves Black

4.9 The Help menu

Help Commands in this menu are the same as in the Help menu for basic
Help... kinetics simulation (Section 2.10).

Mouse Functions...

Formulae...
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5. Epitope mapping

5.1 Background

This application simulates epitope mapping by pairwise binding of
monoclonal antibodies (Mabs) to an antigen. Rabbit anti-mouse Fc
(RAMFc) is immobilized to the sensor chip surface and used to capture
the first Mab. Antigen is then bound to the first Mab and challenged
with the second Mab. If simultaneous binding is observed, the two
Mabs define separate epitopes on the antigen. The principle of epitope
mapping with this technique is discussed in more detail in the
BIAapplication Handbook, Chapter 7.

Simulation of epitope mapping includes the following features:

mapping with up to 6 Mabs in a 6x6 binding matrix

user-defined association and dissociation rate constants for the
separate Mab-antigen interactions (these values affect the theoretical
steady state level for Mab binding)

user-defined Mab concentrations

user-defined association and dissociation rate constants for capturing
the Mabs by RAMFc (these values affect the amount of first Mab
captured by the surface)

bulk contribution to the response for the separate Mab solutions
random variation in the response, to simulate experimental variation
user-defined matrix of interfering pairs, not necessarily symmetrical

evaluation of results in terms of pairs which show positive binding

overlay plot for comparing selected sensorgrams

Note: The terminology used in the epitope mapping application

relates directly to immunological epitope studies. The
application can however be used to simulate other kinds of
multi-binding site mapping experiments, e.g. mapping
multiple ligand sites on a receptor molecule.
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5.2 Running epitope mapping simulation

5-2

To start epitope mapping, click on the Epitope Mapping button in the
BIAsimulation main menu.

5.2.1 Basic run

To run a mapping simulation with the default parameters, simply click
on Run. As each sensorgram is simulated, the check box in the Pairs to
Run matrix is greyed to show that the pair has been run, and values
are entered in the Response Levels matrix for first antibody, antigen
and second antibody. These values represent the response reached at
the end of the respective injections, modified by the random error
factor (which is 0 by default, see Section 5.3 below). A 3x3 matrix of
pairs to run generates 9 sensorgrams (several of which will frequently
overlap for the injection of first antibody and antigen):

=1 BlAsimulation - Epitope Mapping
File Reagents Preferences Help
Response (RU) Sensorgram [ Pairs to Run
20500 Second MADb
! P 12 3 456
19500 1 BEEEBOUODO
- : EEEOOD
Eft" s BEEECOOO
17500 « OJOOOooo
— s JOoOoono
s JODODOOO
e L ‘C"“k A"| |C'—Eﬂ’ Al I ‘ (Rl I
Time (g)
rResponse Levels
Second MADb
FirstMAb Antigen 1 2 3 1 5 3
V7 [ ez [ o[ v 0 || | | |
Figt 2 994 [ 328 | [ 13sq [ o[ 192 | | | | | niection Times ¢s):
MAp 3 [ 960 [ z3q [ [ o[ Taes] [ ]| | | | | Delay Antigen
4 | | | ! || || || || | | | [eo ]| [100 ]
5 | | i || || || || | | | Mab
6 | | |1 | | | | | | | First  Second
Threshold Respunse:l:l

You may change the times of injection and delay between injections by
entering values in the appropriate fields. Using longer injections may
improve the results if binding does not reach a steady state (this is
determined by reagent properties, see Section 5.3).

To perform a new simulation, click on Clear All in the Pairs to Run
frame to clear the grey markings in the matrix, then check the pairs to
be run in the new simulation. You can also click on Check All to check
all pairs, then uncheck the pairs you do not want to run. The
sensorgrams and response levels will be cleared when you start the
new simulation.

You can print the results of the simulation with File:Print (Section 5.4).
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5.2.2 Evaluating response levels

When the simulation is complete, examine the response levels in the
matrix under Second Mab . Enter a threshold value above which
responses are to be regarded as positive and click on Evaluate .
BIAsimulation will mark values above the threshold with a grey

background.
Response Levels
Second MAb
First MAb Antigen 1 2 3 4 5 6
v e [ 222l [ o[ 1328 [ 0 || || |
First 2 [ 994 | 329 [ 1399 | 0] [ 1926] | | | | | |
Mab 3 [ 960] [ 234 [ [ 1408 [ 0] | | | | |
4 | | | i | | || || | | | | |
5 | | | | i || || || || || |
6 | | | | ¢ | || | || || || |
|Clear Response Yalues I Threshold Response: [100 Evaluate

The response levels are influenced by a series of factors (all responses
may be influenced by injection times if steady state is not reached
during the injection):

* The response for the first Mab is determined by the Mab
concentration and kinetics of binding to RAMFc.

* The response for antigen is determined by the amount of first Mab
bound, the antigen concentration, molecular weight and kinetics of
binding to the first Mab.

* The response for the second Mab is determined by the amount of
antigen bound, the Mab concentration and kinetics of binding to the
antigen, and the random error value (see Section 5.3).

* Response levels for Mabs are influenced by the bulk RI contribution.

All response values are simulated as the difference in SPR signal
between the start and end of the respective injection.

5.2.3 Examining individual sensorgrams

When many pairs are run in an epitope mapping matrix, it can be
difficult to distinguish the individual sensorgrams in the simulation.
The Redraw function allows you to examine selected sensorgrams.

When the simulation is complete, the pairs that have been run are

marked in grey in the Pairs to Run matrix. To display one or more
selected sensorgrams:
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1. Click on Clear all to clear all pairs, then click on the pairs you
wish to display to reselect them. (Alternatively, click on
individual pairs that you do not want to display.)

2. Press Redraw. The sensorgram window will be redrawn,
displaying only the selected pairs.

Each time you change the set of selected pairs, press Redraw to redraw
the sensorgram window. To redraw sensorgrams for all pairs that have
been run, press Check All and then Redraw.

5.3 Reagent properties

5-4

To set parameters for reagent properties, choose Reagents:Reagent
Properties .

= Blasimulation - Epitope Mapping - Reagent Properties

MAb Properties
Conc. BulkRI RAMFc RAMFc [ Pairs That Interfere In Binding 7
ka kd (ug/ml)  (RU) ka kd L 2 345 &
vfres | fes J[o w0 Jfes Jfies || s mORORDO
2 [565 | [tea |[s0 ] |40 ] [ses | [1e4 ] :OROORO
3 166 | [503 | [30 | 70 | [3e5 | [5e-4 | sHOKXKOOO
1 |4e4 | |1e—2 | ‘wu | |15 | |?e4 | |5e—4 | +UOOKOK
5 |?es | |5e—4 | ‘120 | |3u | |lel3 | |?e—4 | sHXOUXO
s JOOKONK

5 |29li | |3e—3 HEI] | |—1n | |594 ||le—5 |
MAb Valency: IZI RAMFc Rmax:

rAntigen Properties ] Start Baseline:
Mol. Weight Random Error (RU): ICI
Conc (ug/ml)

Mab Properties
Under ka and kd, enter association and dissociation rate constants
respectively for binding of the Mab to antigen.

Under Conc, enter the Mab concentration in pg/ml.

Under Bulk RI, enter the bulk refractive index contribution of the Mab
solution to the SPR signal in RU.

Under RAMFc ka and kd, enter association and dissociation rate
constants respectively for binding of the Mab to the capturing agent
(immobilized RAMFc).
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Note: The default kinetic constants for Mab binding to RAMFc
represent a wide spread of affinities. This is instructive in
demnostrating the effect of varying capture affinities, but in
practice the affinities of capturing agent for the various Mabs
should be relatively constant.

In Mab Valency , enter the number of antigen molecules which can bind
to one Mab. This is normally 2. The same value is used for all Mabs.
The valency only affects the amount of antigen that can bind to the
first Mab (valency is ignored for binding of the second Mab to
antigen).

In RAMFc Rmax , enter the maximum binding capacity of the RAMFc
surface for Mab in RU.

Pairs That Interfere in Binding

Check the appropriate boxes in this matrix for pairs of Mabs that
interfere in binding. Normally, the diagonal line from top left to
bottom right will be checked (i.e. any one Mab interferes with its own
binding), and the matrix will be symmetrical about this diagonal (i.e.
interference between pairs is not dependent on the order of binding).
You may however check or uncheck any boxes in the matrix. Click on
Clear if you want to clear all boxes.

Antigen Properties
Enter the molecular weight, concentration (pg/ml) and bulk refractive
index contribution (in RU) for the analyte solution.

Baseline
In the Start Baseline field, enter a baseline value in RU to displace the
sensorgrams from the time axis.

Random Error

In the Random Error field, enter a value in RU to simulate
experimental variations in the measurements. A random value up to
this error will be added to or subtracted from the second Mab
calculated response levels before the results are entered in the
Response levels matrix. This error can help to simulate experimental
uncertainty in evaluating positive binding results.

Click on Reset All Values to reset all parameters in the Reagent
Properties dialogue box to their default values.
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5.4 Printing results

To print the results of a simulation, choose File:Print .

O Summary
(® Full page B
O Sensargram
Summary

Choose this option to print a one-page summary of the simulation.
Items printed are the main window (sensorgram with Pairs to Run
matrix, response levels and experimental conditions) and the reagent
properties window.

Full page

Choose this option to print tables (reagent properties and response
levels) and/or sensorgrams on a full page. The tables are printed
together on one page. Sensorgrams are enlarged to fill one page in
landscape orientation.

Notes: Only the sensorgrams currently displayed in the sensorgram
window (see Section 5.2.3) will be printed.

5-6 BIAsimulation Software Handbook



Muilti-site binding

6. Multi-site binding

6.1 Background

This application simulates sequential injections of different analytes to
test simultaneous binding to an immobilized ligand. The following
features are included:

* user-defined properties for up to 6 analytes (referred to as probes)
and one ligand (referred to as the target molecule)

* user-defined interference matrix between probe pairs
» free choice of injection sequence

* evaluation of binding in terms of response level for each probe

6.2 Running multi-site binding simulation

To start the multi-site binding application, click on Multi-site Binding
in the BIAsimulation main menu.

To run a simulation with the default parameters, simply click on Run.
One sensorgram is generated with probe injections in the sequence
specified in the Sequence To Run matrix. The response for each
injection is shown as the difference in SPR signal between the start and
end of the injection. For comparison, the maximum independent
binding capacity of the surface for each probe is also shown (derived
from the reagent properties, see Section 6.3).
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= BlAsimulation - Multi-Site Binding
File Reagenis Preferences Help

Response (RU) Sensorgram
22000

20000
18000
16000

14000
12000
10000

8000
B000
4000

1}

200 400 B00 800 1000
Time (seconds)
 Sequence To Run Resp Level For Each Injection
Injection No. Target Inj. 1 Inj. 2 Inj. 3 Inj. 4 Inj. 5 Inj. &
1 2 3 4 5 6 1000 2797 2980 143 197 n 2848
ARKDOOOOO Probe: A B C D E F
e0E O OO0 ||Rmax(ru: 1000 3000 3000 1400 4000 3000
Pobe  cOOROD0 |
Injected xperimental Conditions
meeet nOpoUROO
EAOd0NOOKO Time of Injection (s)
FOOOOO® Time Between Inj. (s
i (5) S
Baseline (RU) [10000

Probe injection sequence

To change the order of probe injections, check the appropriate boxes
in the Sequence to run matrix. Vertical columns in this matrix
represent injections and horizontal rows represent probes. You can
only check one box in each vertical column (i.e. you can only inject
one probe for each injection), but the same probe may be used in
several injections. For example, the sequence illustrated below would
inject probe A followed by B followed by A again:

rSequence To Run——————
Injection No.

1 2 3 4 5 6
AXOXKOOO
KOO OMN

Pobe — c[]JLI0O0O0O
meeed pOQOODOO
eQoooggd
FUOOOOU

Click on Clear to clear the whole matrix.

Injection parameters

The time of injection (in simulated seconds) and the time between
injections can be changed by entering the required values in the
appropriate fields. The time between injections is particularly relevant
for probes with a relatively high dissociation constant, since probe is
lost from the surface during the delay between injections.
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You can also set a baseline value in RU to displace the sensorgram
from the time axis.

Results

The results of multi-site binding simulation are displayed in the main
window as the response level for each injection, measured from the
beginning of the respective injection and corrected for any bulk
refractive index contributions:

Response Level For Each Injection

Target Inj. 1 Inj. 2 Inj. 3 Inj. 4 Inj. & Inj. B
1000 2797 2980 143 197 1 2648
Probe: A B C D E F

Rmax (RU): 1000 3000 3000 1400 4000 3000

6.3 Reagent properties

To set parameters for reagent properties, choose Reagents:Reagent
Properties .

rProbe Properties
Property Reagent A ReagentB Reagent C ReagentD ReagentE ReagentF
Mol weight: 50000 | 100000 | [150000 | [7o000 | [200000 | [150000 |
Conc. (ug/ml): |50 | [30 | [300 | [a1 | 120 ] [60 |
ka (M-1s-1):  [1.0E+5 | [5.0E+5 | [5.0E+a | [5.0E+6 | [1.0E+6 | [7.0E+5 |
kd (s-1): [10e3 | [1.0E-4 ] [5.0e-3 | [5.0Ea | [10E2 | [5.0E5 ]
Bulk RI (RU):  [20 | [-10 | |60 | [35 | [-20 | [10 |
linterference Matrix Target Molecule Properties
ABCDEF
ANOXKKOO Mol. Weight
BOXOOXO
cHOROOR Immobilised (RU):
pHOOKXKOO OK
FD0EDDE
F |:| D E |:| D E Reset All To Detfault | Cancel

Probe Properties

For each probe used, enter the molecular weight, concentration in
pg/ml, association and dissociation rate constants and bulk refractive
index contribution.
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Interference Matrix

Check the appropriate boxes in this matrix for interference between
pairs of probes. Rows represent the first probe bound and columns
represent the second. Thus a checked box in row B, column D means
that binding of probe B interferes with subsequent binding of probe D.
Normally, the diagonal line from top left to bottom right will be
checked (i.e. any one probe interferes with its own binding), and the
matrix will be symmetrical about this diagonal (i.e. interference
between pairs is not dependent on the order of binding). You may
however check or uncheck any boxes in the matrix. Click on Clear All
if you want to clear all boxes.

Target Molecule Properties

Enter the molecular weight of the target molecule and amount
immobilized on the surface. For each probe, the independent binding
capacity of the surface is calculated from these figures and the
molecular weight of the probe, assuming 1:1 binding stoichiometry.
The binding capacity for a probe is related to the amount of target
molecule immobilized as follows:

_ I\/I\Nprobe
Rmax(probe)_ R targetXWarget

Thus if the molecular weight of the target molecule is 50,000 and
1,000 RU are immobilized, the binding capacity for a probe of
molecular weight 100,000 is 2,000 RU.

Click on Reset All To Default to restore all reagent properties to their
default values.
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6.4 Printing results

To print the results of a simulation, choose File:Print . The print

destination is determined by the current printer setting in Windows
Control Panel.

§] Summary
® Full page 4 :
[l Sensorgram
Summary

Choose this option to print a one-page summary of the simulation.
Items printed are the main window (sensorgram, probe sequence,

response level and experimental conditions) and the reagent properties
window.

Full page
Choose this option to print tables (reagent properties and response
levels) and/or sensorgrams on a full page. The tables are printed

together on one page. Sensorgrams are enlarged to fill one page in
landscape orientation.
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7. Concentration analysis

7.1 Background

This application simulates standard curves for concentration analysis
with BIA based on the response obtained in direct or sandwich assay
protocols. Features include:

* replicate measurements with up to 20 concentrations and 10
injections per concentration

* variation between samples based on random system noise, baseline
drift and regeneration artefacts

* sequential or random injection of samples to simulate the effects of
systematic variations

* mass transport limitations for analyte binding

* CViesponse and CVose values and plots

* sensorgram display

 mixtures of up to 5 secondary reagents for sandwich assays

* estimation of detection limit

7.2 Running concentration analysis simulation

This section describes how to perform and evaluate a basic
concentration analysis simulation. Refer to the detailed command
descriptions (Sections 7.4-7.9) for more information.

7.2.1 Simulating a direct assay
1. Choose Concentration Analysis from the main BIAsimulation
menu. An empty main window is displayed:
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= Blasimulation - Concentration Analysis - Standard Curve - Sandwich Assay

File Plot Parameters Mode Preferences Help

Conc. (M) |Mean (RU) |SD (RUY |CVrEsp("/..) |CVdnse("/..)| CY (%) Standard curve and CV plots R (RLY)
380 1800
3m 1600

1400
280
1200
200 1000
150 800
600
100
400
5 200
0 0
1e-10 1e8  TeB  1e7 1eB  1es  Ted
Concentration (W)

Dose-R curve:
CV - response curve:
CV - dose curve:

Injection Times

Analyte Reagent

¢-| | ‘-0 Association time (s):
Detection Limit Dissociation time (s):
Use data from cycle: El io El Fun
£

Detection limit (M):

2. Choose Mode:Direct Assay .

3. Choose Parameters:Analyte Properties . These properties are filled
in by default. Change the settings if you require:

Sample [Conc [Bulk | Sample injection order. _
1 1E10 0 1 2 3 4 5 6 7 & 9 10 ||[#AnalyteProperies
2 |2E10 0 1 12 13 14 15 16 17 18 19 20 Mol Waight 50000 |
R ght: |5l
3 |4E10 21 22 23 24 25 26 27 28 29 30 E
4 [sE10 31 32 33 34 35 36 37 38 39 a0 ||
5 [16E4 41 42 43 44 45 46 47 48 49 50 !
6 |32E-9 51 52 53 54 55 56 57 58 59 60 Start (>=1E-14 MI[1E-T0_|
7 |64E-9 61 62 63 64 65 B6 67 68 69 70 Increment (G1){2____ |
8 |128E-8 71 72 73 74 75 76 77 78 79 80
9 |256E-8 81 82 83 B4 65 B6 67 BB 89 90 Stepsi[20 |
10 |512E-8 91 92 93 94 95 96 97 98 99 100

101 102 103 104 105 106 107 108 109 110 | |[ Iniection Sequence

111 112 113 114 115 116 117 118 119 120 Inj per conc.: -“.
121 122 123 124 125 126 127 128 129 130

14 [B.19E-7 131 132 133 134 135 136 137 138 139 140 @ n order

15 |1.64E-6 141 142 143 144 145 146 147 148 149 150 © Random

16 |3.28E-6 151 152 153 154 156 156 157 158 158 160
17 |6.55E-6 161 162 163 164 165 166 167 168 169 170

18 1.31E-5
19 2.62E-5
20 5.24E-5

Set Bulk (RU): |:|

171 172 173 174 175 176 177 178 179 180
181 182 183 184 185 186 187 188 189 190
191 192 193 194 195 196 197 198 199 200

~

™

=

&

m

4
coccoccocococoocoooaos

Enter the analyte molecular weight.

Under Concentration Series , enter the starting concentration,
increment factor and number of steps (maximum 20).
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Under Injection Sequence , enter the number of replicates and
choose sequential or random order.

Click on Generate Matrix to generate the injection sequence. The
numbers in the generated matrix represent the sequence
numbers of the injections. If random order is chosen, a new
sequence will be generated each time you click on Generate
Matrix .

In the table to the left of the matrix, enter bulk refractive index
contributions for the samples if required. This will only affect
the appearance of simulated sensorgrams. You must enter the
bulk contribution separately for each concentration.

Click on OK to return to the main window.

4. Under Parameters:Reagent Properties enter the molecular
weight, kinetic parameters, ligand valency and amount
immobilized for the surface ligand. For direct assays, the values
under Secondary Reagent Properties are ignored.

= BlAsimulation - Concentration Analysis - Reagent Properties

[ Surface Ligand Properties
Ligand MW-: ka (M-1s-1):
Ligand valency: I:I kd (s-1):

Amount immobilised (RU):

" Secondary Reagent Properties

Enter value: | 150000

Reagent |Mol wt kass |kdiss |Bu|k Rl Conc

B 1 150000 1.E+b bEA 0 1.E-7

Select [ ] 2 150000 5 E+4 b E-4 0 1.E-6
reagent O] 3 150000 5.E+h 5.E-4 0 1.E-5
mixture O 4 150000 1.E+b 1.E-3 0 1.E-4
B 5 150000 2.E+b 2EA4 0 1.E-3

Cancel 0K I

Click on OK to return to the main window.

5. Additional settings that will affect the simulation are:
Parameters:Regeneration
Parameters:Noise and Drift
Parameters:Mass Transport Parameters  together with Mode:Mass
Transport
See the detailed descriptions in Sections 7.6 and 7.7 for more
information.
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6. Adjust the association and dissociation times in the main window
if required. The response is measured at the end of the specified
dissociation phase. For direct assay, the settings for Reagent are
ignored.

7. Click on Calculate to simulate the concentration analysis. The
results are presented numerically and graphically:

= BlAsimulation - Concentration Analysis - Standard Curve - Sandwich Assay

File Plot Parameters Mode Preferences Help

Conc. (M) |Mean (RU) [SD (RU) _ [Cvresp(%) [Cvdose(%)]] [CV (%) Standard curve and CV plots R (RU)
1.E-10 5.22 5.14E-1 9.061 10.156 a0 8000
2.E-10 10.32 5.49E-1 5.324 5.428 a0

4E-10 20.24 752E-1 3716 3722 5000
BE1D 4063 53361 131 1.324 0

1.6E-9 80.65 5 99E-1 0.743 0.75 60 4000
3.2E-9 159.98 6.4E-1 0.4 0.407 50

6.4E-9 3149 5 79E-1 0.184 018 3000
1.28E-8  |609.77 6.14E-1 0.101 0.107 40

256E-8  [1147.87  6.14E-1 0.054 0.061 30 2000
512E-8  [2040.37  7.63E-1 0.037 0.049

1.02E7  [3269.02  3.6E-1 0.011 0.019 e 1000
2.06E-7  [4489.13  5.4BE-1 0.012 0.038 10

A1E7 5123.61 6.73E-1 0.013 0.149 a a
B18E-7  |5263.46  3.19E-1 0.006 0.419 1e-10 168 1eB  1a7 leB leb  lod
164E-6_ |5296.28  3.47E-1 0.007 1.07 Cancentration ()

328E-6__ |5312.51 5.15E-1 0.01 3.16 Dose - Response curve:

655E-6 _ |5320.67  7.1BE-1 0.013 8737 CV - response curve:

131E5  [5324.48  7.29E-1 0.014 17.778 CV - dose curve:

2.62E5  |5326.72  5.67E-1 0.011 27617

524E-5  |5327.71  6.37E-1  0.013 66.953 [ Injection Times

Analyte Reagent

«[] [+ Association time (s): 100 100
 Detection Limit Di iation time (s): |100 100

Use data from cycle: El to El Plat

Detection limit (M): 1.14E-11

7.2.2 Simulating a sandwich assay

To simulate a sandwich assay, choose Mode:Sandwich Assay .
Sandwich assays are simulated in the same way as direct assays with
the following additions:

¢ The association and dissociation times for the secondary reagent can
be set under Injection Times in the main window.

* A mixture of up to 5 secondary reagents can be simulated, with
different binding kinetics and concentrations for each reagent.
Secondary reagent properties are set under Parameters:Reagent
Properties (see point 4 in Section 7.2.1).

The results of sandwich assay simulation are expressed in terms of

secondary reagent responses. The analyte responses can be examined
together with the sensorgrams (Section 7.2.4).
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7.2.3 Examining the results

Numerical data

The table of numerical results from a simulation presents the mean
response, SD, CV esponse and CVgse values for each concentration. Use
the scroll bar at the }i)ottom of this panel to display the slope of the
standard curve at each concentration point. For a definition of SD and
CV, choose Help:Concentration Analysis Formulae

Grapbhical data

The graphical panel displays the standard curve, CV esponse and CVose
plots as a function of concentration. Drag over an area with the mouse
to zoom the display of that area. Single-click with the right mouse
button to restore the un-zoomed display. Double-click with the left
mouse button in the graph area to display a dialogue box for setting
the axis scales. Double-click with the right nouse button to switch
between full-screen and panel display of the graphs.

In the Plot menu, choose which of the CV plots to display. The plot
will be displayed when the corresponding choice is check-marked.

Note: The concentration axis is fixed as a logarithmic scale in the
graphical display. For an indication of how far the standard
curve is linear, examine the slope values in the numerical
table.

7.2.4 Examining the sensorgrams
To examine the sensorgrams for a simulation, choose Mode:Show
Sensorgrams then click on Run.
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= BlAsimulation - Concentration Analysis - Sensorgram - Sandwich Assay
File Parameters Mode Preferences Help
Response (RU) Sensorgram Conc. B-line |Prim ‘Sec ‘B—Iine
8000 1.E-10 5000. 1.71 0.93 5000.
7500 2.E-10 5000. 2.42 3.43 5000.
— 4.E-10 5000 3.45 5.63 5000
8.E-10 5000 6.36 12.6 5000
6500 1.6E-9 5000 1462 2357 5000
6000 3.2E-9 5000. 27.44 47 67 5000.
5500 6.4E-9 5000. 53.67 94.08 5000.
5000 1.28E-8 5000. 104.25 183.95 5000.
4500 2.56E-8 5000 194.78 343.52 5000
5.12E-8 5000. 346.21 613.06 5000.
ADDDD T . 1.024E-7 5000. 557.07 982.15 5000.
Ti p 2.04BE-7 5000 762.82 1347.02 5000
ime {seconds] 4096E-7 5000 87019 153683 5000
Response (RU)  Response vs Dose 8.192E-7 5000. 894.7 1578.45 5000.
1.638E-6 5000 899.17 1589.65 5000
1400 3.2/7E-6__|5000 9028 1593.37 5000
6.554E-6 5000 902.52 1595.92 5000
900 1.311E-5 5000. 904.2 1598.38 5000.
2.621E-5 5000 904.07 1597.81 5000
00 5.243E-5_ |5000. 904.24 1598.03 5000.
-100 Injection Times
Analyte Reagent
B0 Association time (s): [100 100
T1e-10 1e8 1ef 1e7 1eB 1e-h g4 . - ~ . ™
Cancentration (M) Dissociation time (s): |100 100 | g ‘

The sensorgram panel shows one representative sensorgram for each
concentration. The table shows response values for baseline before
injection, primary response (analyte), secondary response where
applicable and baseline after regeneration. The response vs dose panel
shows the standard curve on a logarithmic concentration scale for
primary and (where applicable) secondary responses.

Systematic variations between cycles (system drift and regeneration
artefacts) are simulated for one cycle per sensorgram, regardless of the
number of replicates requested under Parameters:Analyte Properties

If random injection order is chosen, the concentrations will be listed
and the sensorgrams generated in random order.

To display a single sensorgram, click with the left mouse button on the
corresponding line in the table of concentrations. To display additional
sensorgrams in an overlay plot, hold down the Ctrl key and click the
required additional lines in the table of concentrations. To revert to
display of all sensorgrams, click with the right mouse button anywhere
in the table area.

Most parameters for the simulation can be changed from the
sensorgram window menu in the same way as from the main window
menu. Click on Run after changing parameter settings to recalculate
the sensorgrams.

To return to the main window, choose File:Close or double-click on
the window control box (at the top left corner of the window) to close
the sensorgram window. Changes that you have made to parameter
settings in the sensorgram window are not implemented in the main
window until you click on Calculate in the main window.
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7.3 Detection limit

The detection limit of an assay is defined as the standard deviation of
the blank sample response expressed as analyte concentration
(SDgose(0))- Frequently, the practical detection limit is defined as

3x SDdose(0)~
Response
3 x SD
sD
Detection  Practical Dose
limit detection
limit

8Dgoss(0) 3 % 8Dgose(o)

BIAsimulation does not simulate a blank sample (zero analyte
concentration), and the detection limit is estimated by extrapolating
SD4ose values to zero concentration. Usually, extrapolation from the
first 6 concentrations (spanning a factor of 10 times the lowest
concentration) are adequate for estimating the detection limit.

The detection limit for an assay estimated in this way is shown in the
main window:

Detection Limit

Use data from cycle: to EI

Detection limit (M): 1.14E-11

Note: The value shown here is 1 SDgog¢(0)- Multiply by 3 to obtain
the practical limit of 3 x SD e (0)-

If you want to estimate the detection limit from a different range of
concentrations, change the settings in Use data from cycle . The
detection limit is recalculated automatically.

Click on Plot to display the extrapolation of SD 4y to zero analyte
concentration. This can indicate whether the choice of cycles to use for
extrapolation is suitable (e.g. if the SDyose values increase dramatically
at higher concentrations, you should use fewer cycles).
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Shdose (M) SDdose vs Concentration
Be-11 -
fe-11 7
o
de-111 @ °
o

Je-11 4 "
2e-11 1
Te-11 7

1] Se-10 1e-9 1.5e-9 2e-9 258 Je-9 3.5e-9 4e:9

Concentration (M)
Detection limit =  3.76E-11 Molar | | Close I

7.4 The File menu

Print... 7.4.1 Export Sensorgrams

Exports data from simulated sensorgrams as tab-separated text files
containing RU-time coordinate pairs. This command is only available
in Show Sensorgram mode.

Close

Enter a file name for the exported data in the dialogue box.

File Hame: Directories:
|sandwich_bd | c:\biasim
Ci |
+ = ey +
= biasim
£ bilder
+ +
Save File as Type: Drives:
|Tex1 Files (*.bd) |£I | = c: stacvol_dsk |é|

Note: Analyte and reagent properties and analyte concentrations are
not included in the exported file.
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7.4.2 Print
Prints a summary or selected parts of the simulation. Available choices
differ in the main and sensorgram windows:

Main window

oK
Oﬁummary

Cancel
@Eull page (<] Table

[E Standard Curve

04 Detection Limit Plot

Sensorgram window

Ogummary

Cancel
@Eull page gﬂespnnse Table

4 Sensorgram
[E Dose-Response Plot

Summary
If the Summary button is checked, BIAsimulation will print a 2-page
summary of the simulation.

Full page

If the Full page button is checked, BIAsimulation will print one page
for each of the items marked. The Evaluation item cannot be printed
unless a simulation has been performed.

Note: Only the currently displayed sensorgrams are printed from the
sensorgram window.

7.4.3 Close

Closes the concentration analysis application and returns to the
BIAsimulation main menu. You cannot close the application if a
simulation is running or paused.
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7.5 The Plot menu

Plot

v Plot CVrespons
¥ Plot CVdose

The plot menu is only available in the main window.

7.5.1 Plot CVresponse
The CVesponse plot is displayed in the main window when this option
is checked.

7.5.2 Plot CVdose
The CVyese plot is displayed in the main window when this option is
checked.

7.6 The Parameters menu

Parameters

Analyte Properties...
Reagent Properties...

Regeneration...
Noise & Drift...
Mass Transport Parameters...

Parameters Summary...

7-10

7.6.1 Analyte Properties
Sets the properties of the analyte, analyte concentrations and injection
sequence.

= BlAsimulation - Concentration Analysis - Analyte Properties
Sample |Conc |Bu|k Sample injection order:
=T 1 2 3 4 5 ® 7 8 8 10 ||[AnalyteProperties
2 |2E-10 0 11 12 13 14 15 16 17 18 19 20 Mol Weight
_ Weight:[50000
3 |4E-10 0 21 22 23 24 25 26 27 28 29 30
4 [sE-10 0 31 32 33 34 35 36 37 38 39 40 |
5 |16E8 0 M 42 43 44 45 46 47 48 49 50
6 [32E8 0 |51 52 53 54 55 56 57 58 59 60 Start (>-TE-1AMI[IE-10_]
7 6468 0 61 62 63 64 65 66 67 68 69 70 Increment (312 |
B |1.28E-8 0 71 72 73 74 35 76 77 78 79 80
9 |256E-8 0 81 82 83 84 @5 B6 67 @88 B9 90 Steps:20 |
10 51268 0 91 892 93 94 95 95 97 98 99 100 —
1 10267 0 101 102 103 104 105 106 107 108 108 110 | |['niection Sequence
12 [205E7 0 111 112 113 114 115 116 117 118 119 120 Inj per conc.: [10_|
13 [41E7 0 121 122 123 124 125 126 127 128 129 130 ®1n ord
14 [B19E7 0 131 132 133 134 135 136 137 138 139 140 n order
15 [1.64E6 0 141 142 143 144 145 146 147 148 143 150 O Random
16 [3.28E6 0 151 152 153 154 155 156 157 158 159 160
17 |655E-E 0 161 162 163 164 165 166 167 168 169 170
18 [1.3E-5 0 171 172 173 174 175 176 177 178 179 180
19 [262E-5 0 181 182 183 184 185 186 187 188 189 190
20 |5.24E-5 0 191 192 193 194 195 196 197 198 199 200
Set Bulk (RU): |:|

Analyte Properties
Enter the analyte molecular weight in daltons.

Concentration Series

Enter a starting concentration (M), increment factor and number of
steps. Use exponential notation for the concentration (e.g. enter 5 nM
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as SE-9). The concentrations will be generated accordingly in the
concentration table at the left of the dialogue box.

Injection Sequence

Enter the number of replicates for each concentration and choose
whether to simulate injections in order or in a random sequence (this
can affect the consequences of systematic variations such as
regeneration artefacts, see Section 7.6.3). Click on Generate Matrix to
generate the corresponding sample injection matrix in the panel to the
left. Numbers in this matrix represent the sequence number of the
injections.

Set Bulk (RU)

To simulate a bulk refractive index contribution from the analyte,
click on the Bulk cell for the appropriate concentration in the
concentration table and enter a bulk reponse in RU.

7.6.2 Reagent Properties

Sets the properties of the surface ligand and of the secondary reagent
for sandwich assays.

= BlAsimulation - Concentration Analysis - Reagent Properties

[ Surface Ligand Properties
Ligand Mw- | 150000 ka (M-1s-1):
Ligand valency: I:l kd (s-1):

r Secondary Reagent Properties

Enter value: [150000

Reagent (Mol wt kass |kdiss |Bu|k Rl Conc

4 1 150000 1.E+h 5E-A 0 1.E-7

Select [ ] 2 150000 bE+4 5.E-1 0 1.E-6
reagent ] 3 150000 bEsh 5.E-1 0 1.E-6
mixture 0 1 150000 1.E+6 1.E3 0 1.E-4
O b 150000 2.E+h 2.E-A 0 1.E3

‘Cancel

Surface Ligand Properties

Enter the ligand molecular weight, the ligand valency, the amount of
immobilized ligand and the kinetic constants for ligand-analyte
binding. A ligand valency of 2 means that one ligand molecule can
bind two analyte molecules. Fractional valencies can be entered to
simulate partial ligand activity.
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The maximum analyte binding capacity of the surface is determined by
the amount of surface ligand, the ligand valency and the ligand and
analyte molecular weights according to the equation

MW

analyte

R x ligand valency

=R.. X
max(analyte) ligand M
Y & ligand

Secondary Reagent Properties

Mixtures of up to 5 different secondary reagents can be simulated.
Check the Select reagent mixture boxes for the reagents to be used,
and enter the molecular weight, kinetic constants for reagent-analyte
binding, bulk response and reagent concentration. The total bulk
response for the secondary reagent will be the sum of the bulk
contributions from the individual reagents used.

7.6.3 Regeneration
Sets the type and extent of regeneration artefacts that will be
simulated.

= BlAsimulation - Concentration Analysis - Regeneration

rRegeneration artefacts

O No regeneration artefacts.

® Surface ligand loss - (decreasing baselinefdecreasing capacity)
> Surface ligand decay - (decreasing capacity)
O Build-up of analyte - "carry over ?"

O Residual material - (increasing baseline/decreasing capacity)

Percent per cycle (<=h):

Cancel I 0K I

Choose the required type of artefact and enter the extent of the
artefact in percent. During simulation, the extent is calculated as a
percentage of the appropriate value from the previous cycle (e.g. 1%
surface ligand decay will reduce the analyte binding capacity by 1%
for each cycle without reducing the baseline).

Regeneration artefacts are applied after each cycle. In the sensorgram
window, replicate samples are not simulated, so that regeneration
artefacts are applied once for each concentration.

Regeneration artefacts introduce systematic variation between cycles.
The effect of a regeneration artefact on the standard curve will
therefore differ according to whether the injection sequence is random
or in order.
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7.6.4 Noise and Drift

Sets the level of system noise and baselinedrift.

= BlAsimulation - Concentration Analysis - Noise and Drift

System Baseline Drift———— | [ System Noise =

- Cancel
Drift value range -0.1 to 0.1 . .
RU/second. Noise (/) RU:[1 ]

System Baseline Drift

Enter a value for the baseline drift in RU/s. Baseline drift will affect
the simulated response within each cycle, and will accumulate between
cycles in sensorgram mode.

Note: The drift is specified in RU/s. Baseline drift in experimental
sensorgrams is typically <0.3 RU/min (<0.005 RU/s) for
BIAcore, BlAcore 2000 and BIAlite with active temperature
control, and <1 RU/min (<0.017 RU/s) for BIAlite with passive
temperature control.

System Noise

Enter a value for random noise in the simulated signal. This noise is
the only source of variation between replicate samples. You may wish
to set the noise higher than the typical instrument signal noise to
simulate variations in sample preparation etc. If the noise is set to 0,
replicate samples will be identical: CV values will be 0 and the
detection limit will be meaningless.

7.6.5 Mass Transport Parameters
Sets mass transport parameters for the analyte.

= BlAsimulation - Concentration Analysis - Mass Transport

Approximative Fstimation of Mass Transport Influence
[ Instrument Parameters — | [ Calculated values
Flow Cell Dimensions: Linear flow {m/s):
Length (mm): E 6.67E-03
Width (mm): Cell volumes/second:
Height (mm): 317
Diffusion constant.
(m2/s)
Flow: 8.24E-11
(microliters/minute) Mass transport coefficient
[ Solvent properties MTC)
Relative viscosity: EL0SE
Analyte Properties ———— |
Molecular Weight: W‘
Friction factor: Help I |_'§;| Cancel I

This dialogue box is described in detail in Section 2.5.1.
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7-14

Notes: The analyte molecular weight values in Mass Transport

Parameters and Parameters:Analyte Properties  are linked, so
that a change in one is automatically reflected in the other.
The mass transport coefficient is recalculated automatically if
the analyte molecular weight is changed in the
Parameters:Analyte Properties  dialogue box.

To simulate mass transport effects, Mode:Mass Transport On
must be checked.

Mass transport limitations are only simulated for analyte
binding. Binding of secondary reagents in a sandwich assay is

not affected by mass transport settings.

7.6.6 Parameters Summary

Displays a summary of the parameters settings for the current

simulation.

BlAsimulati

Concentration Analy.

[ Surface Ligand Prop

Molecular weight: 150000
Valency: 2
Amount immobilised (RU): 5000
Association rate constant (M-1s-1): 1.E+5

Dissociation rate constant (s-1): 1.E-3

[ Analyte Properties

Molecular weight: 50000
Saturation response (RU): 1000.
The analyte will be injected at 20 concentrations
ranging from 1.E-10 to 5.243E-5 M.

10 injections will be done at each concentration. The
injection order is ordered.

Parameters Summary

[ System Parameters
Noise (+/-RU): .01
Baseline drift (RU/s): 0

Mass Transport influence is not selected

Flow cell length (mm): 2.1
Flow cell width {(mm): 0.5

Flow cell heigth {mm): 0.05
Yolumetric flow (ulfs): 10

Relative viscosity: 0.89
Friction factor: 1.2

Diffusion constant (m2/s): 8.24E-11
Mass transport coefficient: 1.106E-05

" Secondary R Properties
The selected mode is Sandwich Assay.

1 secondary reagent has been selected.

[ Analysis Cycle Parameters

Analyte  Reagent
Association time (s): 100 100
Dissociation time (s): 100 100

ation

Reg
( Surface ligand loss - (decreasing baseline/decreasing

Percent per cycle: 1

BIAsimulation Software Handbook
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7.7 The Mode menu

Mode

Mass Transport On

Y Sandwich Assay
Direct Assay

Show Sensorgram...

7.7.1 Mass Transport On

Determines whether mass transport limitations (see Section 7.6.5) will
be simulated for analyte binding. Mass transport effects are considered
when this command is checkmarked.

7.7.2 Direct Assay

Selects direct assay mode. In this mode, the response is based on
binding of the analyte. Secondary reagent settings (see Section 7.6.2)
are ignored.

7.7.3 Sandwich Assay

Selects sandwich assay mode. In this mode, the response is based on
binding of the secondary reagent. Both primary (analyte) and
secondary responses are shown in sensorgram mode.

7.7.4 Show Sensorgram

Displays the sensorgrams for the simulation (see Section 7.2.4). In this
mode, one cycle is simulated for each concentration used, regardless of
the number of replicates set under Parameters:Analyte Properties

7.8 The Preferences menu

Preferences

All Curves Black |

7.8.1 All Curves Black

Displays all curves in black. Use this setting if you want to print
simulation results on a printer which does not handle colours
satisfactorily. (Most monochrome printers render colours as shades of
grey, but some printers may produce unsatisfactory results for light
colours).

Note: Changing this setting affects subsequent simulations but does
not change the display of the current simulation.
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7.9 The Help menu

Help

Help...

Mouse Functions...

Formulae...

Loncentration Analysis Formulae...

7-16

7.9.1 Help

In general, click with the right mouse button on a text area to display
help for the item (e.g. click on Bulk Resp (RU) in the Reactant
Properties frame for help on this parameter). This works on all text
which serves to identify an input or display field.

7.9.2 Mouse functions
Displays a summary screen of mouse operations, including a small
sensorgram display for practice.

7.9.3 Formulae

Displays a summary screen showing the formulae used in simulating
basic kinetics (see Section 2.1). These equations are used to generate
the sensorgrams from which the simulated responses are measured.

7.9.4 Concentration analysis formulae
Displays a summary screen showing the formulae and definitions used
in concentration analysis simulation

= BlAsimulation - Concentration Analysis - Formulae

SDresponse - Standard deviation of the response.

Y E-n 2

n-1

SDresponse = Unit: RU X;= response value number i

x = mean value for all observations

CVresponse - Coefficient of variation for the response. n = total number of observations

SDi
CV¥response = w -100 Unit: %
SDdose - Standard deviation of the dose. ! CV¥dose - Coefficient of variation for the dose.
Fesponse
Cvdose - —29952 409 Unit: %
Dose

SDresponse

Detection limit.

L - Detection limit = SDdose when the Dose is zero.
SDdose Dase
Unit: Molar

aDdose - SDresponse

Slope of the Standard Curve

Unit: Molar
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All Curves Black , 1-4
analyte properties
concentration analysis, 7-10
antigen properties in epitope mapping, 5-5
association kinetics, 2-2
association time, see experimental parameters
asymmetrical molecules, 2-12
averaging window, 2-13

baseline. see experimental parameters
epitope mapping, 5-5
multi-site binding, 6-3
baseline drift. see drift
basic kinetics, 2-1
basic mode, 2-16
bulk response, 2-6
concentration error, 2-15
concentration units, 2-23
drift, 2-14
Evaluate menu, 2-18
evaluating simulated sensorgrams, 2-19
examples, 2-21
Examples menu, 2-21
experimental parameters, 2-7
extended mode, 2-16
File menu, 2-8
Help menu, 2-24
Mode menu, 2-16
noise, 2-13
Parameters menu, 2-11
Plot menu, 2-9
plots, 2-9
Preferences menu, 2-23
printing, 2-8
reactant properties, 2-6
basic mode, 2-16
BIAevaluation software, 1-1
bulk response
basic kinetics, 2-6
concentration analysis, 7-11
colours, 1-4
concentration analysis, 7-1
analyte properties, 7-10
bulk response, 7-11
concentration series, 7-10
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detection limit, 7-7

direct assay, 7-1, 7-15

drift, 7-13

exporting sensorgrams, 7-8

File menu, 7-8

Help menu, 7-16

injection sequence, 7-11

Mode menu, 7-15

noise, 7-13

Parameters menu, 7-10

Plot menu, 7-10

Preferences menu, 7-15

printing, 7-9

reagent properties, 7-11

regeneration artefacts, 7-12

sandwich assay, 7-4, 7-15

secondary reagents, 7-4

sensorgrams, /-5, 7-15
concentration error

basic kinetics, 2-15
concentration series

concentration analysis, 7-10

heterogeneous analyte kinetics, 4-4, 4-7

heterogeneous ligand kinetics, 3-4, 3-7
concentration units, 2-23
cooperativity, 2-3, 2-15
CVdose, 7-5, 7-10
CVresponse, 7-5, 7-10

detection limit in concentration analysis, 7-7
diffusion constant, 2-4, 2-12
direct assay, 7-1, 7-15
dissociation kinetics, 2-2
dissociation time. see experimental parameters
drift
basic kinetics, 2-14
concentration analysis, 7-13
typical instrument values, 2-14
dynamic range of BIA, 1-2
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entering numerical values, 1-4
epitope mapping, 5-1
baseline, 5-5
evaluating response levels, 5-3
examining individual sensorgrams, 5-3
pairs that interfere in binding, 5-5
random error, 5-5
reagent properties, 5-4
response levels, 5-3
Evaluate menu
basic kinetics, 2-18
heterogeneous analyte kinetics, 4-7
heterogeneous ligand kinetics, 3-8
evaluating
basic kinetics, 2-19
epitope mapping, 5-3
Examples menu in basic kinetics, 2-21
experimental design, 1-1
experimental parameters
basic kinetics, 2-7
heterogeneous analyte kinetics, 4-4
heterogeneous ligand kinetics, 3-4
multi-site binding, 6-2
exporting sensorgrams
basic kinetics, 2-8
concentration analysis, 7-8
extended mode in basic kinetics, 2-16

File menu
basic kinetics, 2-8
concentration analysis, 7-8
heterogeneous analyte kinetics, 4-6
heterogeneous ligand kinetics, 3-7
flow cell dimensions, 2-11
flow rate, 2-11
friction factor, 2-4, 2-12

help, 1-4
concentration analysis formulae, 7-16
general, 2-24
kinetic formulae, 2-24
mouse functions, 2-24, 7-16
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Help menu

basic kinetics, 2-24

concentration analysis, 7-16
heterogeneous analyte kinetics, 4-8
heterogeneous ligand kinetics, 3-8

heterogeneous analyte kinetics, 4-1

concentration series, 4-4, 4-7
Evaluate menu, 4-7
experimental parameters, 4-4
File menu, 4-6

Help menu, 4-8

Mode menu, 4-7

Plot menu, 4-6

Preferences menu, 4-8
reactant properties, 4-3
single analyte mixture, 4-7

heterogeneous ligand kinetics, 3-1

concentration series, 3-4, 3-7
Evaluate menu, 3-8
experimental parameters, 3-4
File menu, 3-7

Help menu, 3-8

Mode menu, 3-7

overlay plots, 3-6, 3-7

Plot menu, 3-7

Preferences menu, 3-8
reactant properties, 3-3
single analyte concentration, 3-7

high response levels, 1-2
hindrance, 2-3, 2-15

individual sensorgrams in epitope mapping, 5-3
injection parameters in multi-site binding, 6-2
injection sequence

concentration analysis, 7-11
multi-site binding, 6-2

interface techniques, 1-2
interference matrix in multi-site binding, 6-4

learning aid, 1-1

BIAimulation Software Handbook



Index

Mab properties in epitope mapping, 5-4
mass transport
effects, 2-17
in concentration analysis, 7-14, 7-15
overlay plots, 2-17
parameters, 2-11
rate equations, 2-3
simulating, 2-5
mass transport coefficient, 2-4
Mode menu
basic kinetics, 2-16
concentration analysis, 7-15
heterogeneous analyte kinetics, 4-7
heterogeneous ligand kinetics, 3-7
multi-site binding, 6-1
baseline, 6-3
injection parameters, 6-2
injection sequence, 6-2
interference matrix, 6-4
reacent properties, 6-3
results, 6-3

negative cooperativity, 2-15
noise
basic kinetics, 2-13
concentration analysis, 7-13
effect on CV in concentration analysis, 7-13
typical instrument values, 2-13
number of surface binding sites, 2-12
numerical values, 1-4

overlay plots
for mass transport effects, 2-17
heterogeneous ligand kinetics, 3-6, 3-7

Parameters menu
basic kinetics, 2-11
concentration analysis, 7-10

Plot menu
basic kinetics, 2-9
concentration analysis, 7-10
heterogeneous analyte kinetics, 4-6
heterogeneous ligand kinetics, 3-7
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plot window
full screen, 1-3
scale, 1-3
zoom, 1-4
positive cooperativity, 2-15
Preferences menu
basic kinetics, 2-23
concentration analysis, 7-15
heterogeneous analyte kinetics, 4-8
heterogeneous ligand kinetics, 3-8
printer setup, 1-4
printing
basic kinetics, 2-8
concentration analysis, 7-9
epitope mapping, 5-6
evaluation results, 2-20
multi-site binding, 6-5
probe properties in multi-site binding, 6-3

RAMFc properties in epitope mapping, 5-4
random error in epitope mapping, 5-5
rate equations, 2-2
reactant properties
basic kinetics, 2-6
heterogeneous analyte kinetics, 4-3
heterogeneous ligand kinetics, 3-3
reagent properties
concentration analysis, 7-11
epitope mapping, 5-4
multi-site binding, 6-3
regeneration artefacts in concentration analysis, 7-12
response levels
correlation with surface concentration, 2-4
epitope mapping, 5-3
results
concentration analysis, 7-5
multi-site binding, 6-3
Rmax, 2-12
running
basic kinetics, 2-5
concentration analysis, 7-1
epitope mapping, 5-2
heterogeneous analyte kinetics, 4-2
heterogeneous ligand kinetics, 3-2
multi-site binding, 6-1
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sandwich assay, 7-4, 7-15
scale, 1-3
secondary reagents in concentration analysis, 7-4, 7-12
sensorgram window
full screen, 1-3
scale, 1-3
zoom, 1-4
sensorgrams in concentration analysis, 7-5, 7-15
setting scale, 1-3
simulated time, 1-4
simulation speed, 1-4
single analyte concentration
heterogeneous ligand kinetics, 3-7
single analyte mixture
heterogeneous analyte kinetics, 4-7
solvent viscosity, 2-4, 2-12
specific response, 2-4
steric hindrance, 2-3, 2-15
surface ligand properties in concentration analysis, 7-11
surface saturation, 1-2
system noise. see noise

target molecule properties in multi-site binding, 6-4
text files, 2-8
theory
heterogeneous analyte kinetics, 4-1
heterogeneous ligand kinetics, 3-1
interaction kinetics, 2-1

viscosity, 2-4, 2-12

zoom, 1-4
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